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Purpose of this guide
Welcome to Centrus Desktop. This User's Guide is intended to provide you with the 
information you need to effectively use Centrus Desktop. The information contained in this 
guide include name-and-address matching concepts, defining and running batch jobs, and 
using the interactive Centrus Desktop functions.

If you need more help
If you are unable to resolve a problem, a Precisely Technical Support Representative can 
help guide you to a solution. To open a Support case, go to 
https://support.precisely.com/casemanagement/. When you contact Precisely Technical 
Support, please have the following information ready:

•  A description of the task you were performing.
•  The resulting reports (specifically, the Execution Log and Parameter Record 

Listing).

Reporting complete details to Technical Support will help you and the technical support 
representative resolve the problem quickly .

The Website

You can also find out about Precisely software products and services on our website: 
https://www.precisely.com.

Related publications
The following publications may provide useful information for working with Centrus 
Desktop:

• GeoStan Geocoding Suite Utilities Reference Manual
• Centrus Desktop Release Notes

To obtain additional user guides

To obtain electronic copies of our product manuals, go to :https://support.precisely.com.

https://www.precisely.com
https://www.precisely.com
https://support.precisely.com/casemanagement/
https://support.precisely.com/casemanagement/
https://support.precisely.com
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Starting Centrus Desktop
To open or start Centrus Desktop, click Start > All Programs > Centrus > Centrus 
Desktop > Desktop. By right clicking on Desktop, you can create a shortcut to your 
desktop for ease of use later.

Understanding the Centrus Desktop window
The window that opens after launching Centrus Desktop allows you to access all the 
options and tabs.

From the menu and toolbar you have the following options listed in the table below:

Option Description

New Task From the menu, click File and select New Task, or select the   icon from 
the toolbar. 
This option clears the current task and creates a new task. For more 
information see Creating an Address Coding task or Creating a Closest Site 
and Point-in-Polygon task for more information on tasks. 

Open Task From the menu, click File and select Open Task, or select the  icon from 
the toolbar. 
This option opens a previous task. 

Menu - allows access to most options.

Toolbar - quick access to some options.

Tabs - allows access to specific functions and options.
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Save Task / Save Task As From the menu, click File and select Save Task or Save Task As, or select 
the  icon from the toolbar. 
This option saves your task. For an example of saving a task, see Creating 
an Address Coding task.

Configuration From the menu, click File and select Configuration. This option allows you 
to specify the location of the necessary data files to run Desktop. For more 
information see “Changing the location of Centrus data files” on page 85, 

Recent File From the menu, click File and select Recent File. If this option is not 
available, the most recent file is listed from the File menu. 

Exit From the menu, click File and select Exit, or select the           icon from 
the top right of the Centrus Desktop window. This option closes Centrus 
Desktop. 

Clear Outputs/
Clear All Outputs

From the menu, click Edit and select Clear Output or Clear All Outputs. If 
you wish to reuse a task, you can change its settings to suit any new 
requirements.
• Clear output fields within the current module.
• Clear outputs fields in all modules.
• Clear outputs fields in all modules except the current module.
• Clear previously defined outputs within the current module (Clear Current 

Outputs).

Clear All Except From the menu, click Edit and select Clear All Except. This option clears all 
other tabs, but the one specified from the menu.

Standardization Defaults From the menu, click Edit and select Standardization Defaults. There are 
two fields from which to chose, Existing Fields and New Fields. For more 
information on this option see  Common elements in standardization.

Geocode Defaults From the menu, click Edit and select Geocode Defaults. There are two 
fields from which to chose, Existing Fields and New Fields. For more 
information on this option, see Common elements in geocode data. 

Quick Find From the menu, click Tools and select Quick Find, or select the  icon 
from the toolbar.
This option opens the Quick Find window for a faster address lookup. You 
can access a variety of information about a particular address: match codes, 
demographics, and geographic data. For more information see Using Quick 
Find. 

Data Viewer From the menu, click Tools and select Data Viewer, or select the  icon 
from the toolbar.
This option allows you to examine the contents of the output file one record 
at a time. For more information see Data Viewer.

Map Viewer From the menu, click Tools and select Map Viewer, or select the  icon 
from the toolbar.
This option allows you to see streets and county boundaries for the city 
currently entered. A map displays the currently geocoded point, and you can 
manually move that point to retrieve information on another location. For 
more information see Using Map Viewer.

Option Description
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The tab options are as follows:

• Tables - Creates Input and Output tables as well as Report Files. For more information 
see Creating an Address Coding task or Creating a Closest Site and Point-in-Polygon task.

• Address Coding - Corrects, standardizes and geocodes your address data. You must 
use this module if you wish to ensure that your addresses comply with USPS and CPC 
standards. Refer to Using Address Coding for more information.

• Demographics - Applies United States Census demographic data to your addresses. 
Refer to Using Demographics and Geographic Determination for more information.

• Point-in-Polygon - Determines whether an address falls within a particular area. Refer 
to Using Closest Site and Point-in-Polygon for more information.

• Closest Site - Evaluates the relationship between two geocoded points. Closest Site 
can help you calculate the distance between points or boundaries. Refer to Using Closest 
Site and Point-in-Polygon for more information.

Shape Layers From the menu, click Tools  and select Shape Layers, then Import, Export 
or Generate PMA. You can also select the Generate PMA    icon from 
the toolbar.
This option allows you to create and export geography files based on your 
address data. You can also generate Primary Market Areas (PMAs). If you 
have a location-dependent business, a PMA can help you identify market 
overlap and pockets of untapped opportunity. You can use your existing 
database with a PMA to create a precise polygonal boundary file using the 
outermost address points of customers or prospects surrounding your store 
or office location. For more information see Shape Layers. 

Options From the menu, click Process and select Options, or select the  icon 
from the toolbar.
The Options window contains the options for the tabs below.

Verify Tables From the menu, click Process and select Verify Tables. After creating a 
task, by selecting Verify Tables, Centrus Desktop verifies that all pertinent 
information was entered.

Verify All From the menu, click Process and select Verify All.  You can verify the 
settings for all modules, or you can verify the settings for the currently-active 
module (tab). This enables you to verify that you have correctly specified 
your tasks. 

Verify Current From the toolbar, select the  icon. This option verifies the outputs for the 
selected tab. 

Process Task From the menu, click Process and select Process Task., or select the  
icon from the toolbar.
For more information see,Creating an Address Coding task or Creating a 
Closest Site and Point-in-Polygon task.

Batch Process Task From the menu, click Process and select Batch Process Task. For more 
information see,Creating an Address Coding task or Creating a Closest Site 
and Point-in-Polygon task.

Help From the menu, click Help, or select the   icon from the toolbar.
This option opens the Help Topics window or the About Centrus information 
window. 

Option Description
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• Geographic Determination - Describes the spatial relationship between two entities, 
along with the degree of confidence in that description. Geographic Determination 
allows you to determine the likelihood that a given address falls within a targeted area. 
Refer to Using Demographics and Geographic Determination for more information.

Note: Depending on your license, your Centrus Desktop installation may not include every 
option listed here. Contact your Precisely sales representative for information on 
adding a module.

Licensing
Note: This is not a complete guide to your license terms! Please review your license 

carefully for more information.

Centrus Desktop uses several data files, which are available for download from the 
Precisely Data Experience site. How many of these data files you can use depends upon 
your license agreement. The data files you are licensed to use are installed during the data 
installation process.

Note: Refer to the Installation Notes for the Centrus Data Products Suite for data 
installation instructions.

Your contract with Precisely determines the license and security files you need. The 
centrus.lic file is the licensing file for Centrus Desktop and its associated modules. 

Note: License renewal is automatic; you do not need to take any action to renew your 
license. You must, however, provide written notice to Precisely if you do not wish 
to renew.

To see version, license expiration, copyright details, and data file library information, click 
Help > About Centrus from the main Centrus Desktop menu. Click Library Information to 
see additional information about the currently loaded data files.
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Using Quick Find
The Quick Find option is usable after launching Centrus Desktop. The Quick Find option is 
the easiest and fastest way in which to perform an address search.

To use Quick Find:

1. From the menu, click Tools and select Quick Find, or select the  icon from the 

toolbar.

The Quick Find window opens.
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Listed below are the options available from this window:

Option Description

Standard This is the default tab when the Quick Find window opens. 
Enter a standard three-part address into the text boxes, and click Find to process the 
address.
• If a match is made, use the Map function to map the current address. If a match is 

not made, click Query to access the Query function, which can help resolve the 
address.

• The Copy Mailing Address To Clipboard button copies the Firm Name (if 
available), Address Line, Address Line 2 (if available), and Last Line to the 
Clipboard.

• The Print button displays the output in Notepad.

NOTE: The information copied to the Clipboard is from the results tree, rather than 
the input boxes. Hence, the information is only available after Centrus Desktop finds 
a successful match.

Multiline Enter a free-form address into a single text box, and click Find to process the address. 
This option is for addresses that are more that one line long. For example:
Attn. Product Management
Precisely
4750 Walnut St.
Ste 200
Boulder, CO 80301
• If a match is made, use the Map function to map the current address.
• The Private Mail Box Designator and Private Mail Box Number output address 

elements are not available.
• The Query function is unavailable in Multiline mode.

NOTE: This option does not affect Canadian processing.

Address Wizard Verifies that you have supplied correct and complete information. Address Wizard 
mode corrects all elements of an address.
• If you enter an address that is known to have apartments or multiple units, a dialog 

box displays with the possible unit numbers. Enter the unit number and click OK.:
• If the address has more than one possible match, a dialog appears with the possible 

matches. Select the appropriate street name and click OK:

NOTE: This option does not affect Canadian processing.

• The Auto Search option at the bottom of the window tells Address Wizard to begin 
searching after a few seconds of keyboard inactivity. Address Wizard also attempts 
a match on partial addresses.

• If Auto Search is not checked, you must click Find or press Enter to perform the 
address lookup.

Find Click Find, after entering an address, to run the address search.

Print Click Print to print out address results.

Reset Click Reset to clear entered address information. 

Map Click Map to view address results in a map. 

Query By clicking Query, the Resolve the Address window opens. Available only with the 
Standard and Address Wizard tabs. See Navigating the Query directory  for 
more information on the Query directory, and see Specifying the Search Filter 
for more information on the Search Filter section of the Resolve the Address window.
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2. To search for a standard address, enter the known address information in the fields 
given in the Standard tab.

• If you have a multiline address as explained above for the Multiline tab, enter that 
address is the field provided.

3. Click Find.

• For more information on the results in the Results screen, see Status codes.
• If applicable, complete the information in the USPS Mailer Information dialog box.

The USPS Mailer Information dialog box only appears if you select address elements 
that contain DPV, LACSLink, or SuiteLink information. The USPS requires this 
information for processing of false-positive matches that may occur when processing 
records for DPV or LACSLink data. Note the path to the false-positive report file in case 
GeoStan™ encounters a false-positive address while processing. Select the Save 
values as Centrus Desktop defaults checkbox, and Centrus automatically populates 
the fields the next time the window appears.

Navigating the Query directory
Note: Double-click any entry in the query directory to expand or contract it. Double-click a 

house-range entry to accept it as the correct record and paste it into the Results 
section of the Process window.

When a query result first displays, the Records section displays Country and State. Queries 
display in a hierarchical nature in the Records section of the Query window. Each level of 
the hierarchical directory is indented below its parent level. All entries are sorted 
alphabetically, including Street Block and House Range.

The following table describes the levels of the directory:

Help Click Help to open the Help Topics window.

Cancel Click Cancel to end address search and close the Quick Find window.

Option Description

Level Description

Country Always USA. The Centrus Desktop area is the 50 states and Washington, 
D.C., plus Puerto Rico and other U.S. Protectorates.

State Displays the two letter state abbreviations that match the search filter criteria. 
If the ZIP Code is for a different state, two state abbreviations display.

City Displays the city names that match the search filter. If the City entry in the 
filter is “C”, then all city names beginning with “C” display. Some city names 
are displayed with a different name in parentheses. The name in parentheses 
is the city name the USPS wants you to use when mailing to that location. The 
name outside of the parentheses is a name that the USPS recognizes and 
may not be a city name at all. These names might be buildings, military 
installations, or even large corporations.
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Any adjustment of the Search Filter collapses the Query directory to the proper point. For 
example, if you modify the House, Street, or Unit, the directory collapses to the City level.

Specifying the Search Filter
The Search Filter section of Query allows you to specify the limits of your query. In general, 
the more information you enter into the search filter, the more refined the search results, 
which means that fewer possible matches display in the Records section.

At a minimum, the Search Filter requires you to enter a city and state, or a ZIP Code. If the 
entered city and state are for one state but the ZIP Code is for a different state, the two 
states display in the Records section, and you must choose which state to search.

The Search Filter section contains the following fields:

• The House entry optionally specifies a house number. You can use this to limit the 
search to only those streets that have a block on which that house number would fall. If 
you enter 1000, a house range of 200-300 does not match. If this entry is blank, all 
ranges match.

• The Street entry may contain zero or more characters. If this entry is blank, all streets 
are displayed. If the Street entry was “APPLEW”, streets with the name of “Applewood” 
or “Appleworm” would both match, but “Apple” would not.

Note: The Street entry should be a base street name only; it should not contain pre-
directionals, post-directionals, or street types. For example, “Vine” is a valid entry 
for Boulder, CO, but “Vine PL” is invalid due to the additional street type (“PL”).

• The Unit entry is similar to the House entry, except that it contains the unit number, such 
as “12” or “E”. House ranges that do not contain the given unit number do not display. 
Because the USPS does not list separate unit numbers for all buildings, house range 
entries that do not have any unit numbers match any unit number entered. This is 
consistent with USPS CASS requirements.

• The City entry takes at least the first letter of the cities to be displayed. Centrus Desktop 
displays all the cities within the given state which match the letters in the City entry. The 
state abbreviation, however, must be a recognized state abbreviation or Centrus 
Desktop ignores the entries for both City and State.

Street Name Contains the full street name including directionals and street type. For 
example, there are separate entries for “N Main St” and “S Main St”. A street 
may also appear with (Alias) next to the street name, which indicates Centrus 
Desktop used a different name to match the street name with the search filter.

Street Block Contains one block of house ranges. A Street Block often is the same as an 
actual city block, but not always. In some instances, a Street Block may 
represent a partial city block. Less frequently, a Street Block represents 
several city blocks. Street blocks list a range of all house numbers that might 
appear on that block.

House Range Displays the actual range information contained in the USPS files. For 
example, 1000-1098 Kearney St NE, 20017-4526 (S,E). The first part of this 
line is the house range and full street name. The next entry is the 9-digit ZIP 
Code for that house range. In parentheses are displayed the Record Type 
and Record Parity.

Level Description
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• The ZIP entry generates the list of possible cities. It does not determine which entries 
Centrus Desktop displays in the Records section. The Zip entry must be a valid five-digit 
or three-digit ZIP Code. Three-digit ZIP Codes are commonly referred to as Sectional 
Centers. A Sectional Center is comprised of all five-digit ZIP Codes that begin with 
those three digits.

Map Viewer
The Map Viewer displays a geocoded point, with additional information such as streets and 
county boundaries. You can manually move the point to retrieve information about a 
different location, or to allow users with local knowledge to place points for locations that 
Centrus Desktop did not match.

Note: There are no street segments available for mapping when using USPS-only data 
because USPS-only data does not contain Street data, only Postal information. There 
are also no street segments available for mapping for Canada.

Using Map Viewer
To use the Map Viewer:

1. Select Tools > Map Viewer from the menu or click the icon  from the toolbar.

Note: You can also click Map within Quick Find or Process dialog boxes to display the 
Map Viewer.

2. When the Locator window opens, enter the address.

3. Click either Zoom Street or Zoom City.

• Zoom Street - Shows the street entered with the address.
• Zoom City - Shows the city entered with the address.
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4. When the Map Viewer window opens, your entered address is mapped. As seen 
below:
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The map view can be customized using the following options in the Map Viewer 
window:

Option Description

Redraw Redraws the map at the same scale.

Zoom In Increases the magnification. To zoom in, click the button, then click the map.
You can also define an area to be magnified. Click the Zoom In button, then click and 
drag the pointer over the map window to define the area to be zoomed.

Zoom Out Decreases the magnification. To zoom out, click the button, then click the map.

Center Redraws the map with the selected point at the center of the map window. To center 
the map on a point, click the button, then click the map at the new point.

Select Allows you to manually place a point on the map. See “Geocoding manually 
with the Map Viewer” on page 22 for more information.

Info Displays information on a street segment. Position the square cursor over a mapped 
street and click to view information about the street segment.

Locate Opens the Locator dialog box, where you can enter an address or city to locate on 
the map.
To locate a street, enter the street address, city, state, and ZIP Code (if known). Click 
Zoom Street to display all street segments in the specified city with a matching street 
name.
To locate a city, type either the city name and the state abbreviation, or a ZIP Code. 
Click Zoom City to display the streets in the city or ZIP Code within the map window.
The Zoom Street function does not work correctly if street input includes street type 
or pre-/post-directionals, such as WEST or PLACE. Enter only the street name in the 
Street box. 

Layers Opens the Layers dialog box. See Using Layers for more information.

Zoom Extent Allows you to specify one or more spatial layers and zooms the map window to show 
all features within the specified layers.

Help Displays the Centrus Desktop online help.

OK Displays the most recently geocoded location and closes the Map Viewer. If you 
manually geocoded a point, the Census ID, latitude, and longitude appear in the 
Results section of the QuickFind or Process dialog box.
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Using Layers

To modify layers, from the Map Viewer, click  to open the Centrus - Layers window...

This window allows customization of the layers drawn on the map. By selecting a layer, as 
in the example above, trade is highlighted. The trade lines, points, labels, and thresholds 
are available for specification.

Select the desired layer by entering a check mark in the box.

The following options are available in the Centrus - Layers window:

Option Description

Layers (In Drawing Order)

Primary Streets This category includes nationally and regionally 
important highways. It consists mainly of US 
highways, but may include some state highways 
and county highways that connect cities and larger 
towns. A road in this category must be hard-surface 
(concrete or asphalt). It has intersections with other 
roads, may be divided or undivided, and have multi-
lane or single-lane characteristics.

Secondary Streets This category includes mostly state highways, but 
may include some county highways that connect 
smaller towns, subdivisions, and neighborhoods. 
The roads in this category generally are smaller 
than roads considered Primary, and must be hard- 
surface (concrete or asphalt), and are usually 
undivided with single-lane characteristics. These 
roads usually have a local name along with a route 
number and intersect with many other roads and 
driveways.
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Confidence Surface This displays when using Geographic 
Determination.
This category produces a confidence surface 
around a geocode, segment(s), or area.

NOTE: Additional layers listed are from user imported information.

Up and down arrows The arrows to the right of the Layers window allow 
the priority of the drawing order to change.
By selecting a layer, click up or down to move the 
layer closer to the beginning or the end of the map 
drawing.

Visibility Threshold Enter mileage limits using the arrows or enter 
desired number directly into the field.

Show Label

Font Select the desired font.

Size Select the font size.

Color Select the color of the displayed label.

Region/Line

Line Style Select line type.

Width Select line width.

Color Select line color.

Fill Style Select line fill.

Color Select line fill color.

Point

Symbol Select the point indicator.

Size Select the point indicator size.

Color Select the point indicator color.

Custom Select alternative point indicator.

... Click to browse for alternative point indicator.

Background Color Changes the background color for the map.

Help Opens the Centrus Desktop User Guide.

Cancel Closes the window.

OK Accepts changes to the layers.

Option Description
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Geocoding manually with the Map Viewer
If Centrus Desktop is unable to match an address, you can assign information to the point 
manually. This is most useful if you have knowledge of the area or other maps to which you 
can refer.

To manually geocode addresses with the Map Viewer:

1. Locate the spot to place the point using the Zoom and Info buttons, as well as a 
nearby street whose Census ID and coordinates you wish to assign to the new 
location.

2. Click Select, then click and hold on the site to geocode. This anchors the point.

3. Drag the pointer to the street segment whose Census ID you wish to assign to the new 
location, creating an attach line between the point to be geocoded and the existing 
street segment.

Centrus Desktop assigns the Census ID and coordinates of the selected street segment 
to the new location. In the message area at the bottom of the screen, the Census ID 
displays, as well as the side of the street associated with the ID.

An address that has been manually geocoded displays a location code of M.

Spatial attributes
After you import a shape file into a Spatial attribute layer, you can use QuickFind to view the 
information, including all potential output fields. You can then decide which fields to use in 
your processing run.

Spatial attributes do not process special characters. All characters between 31 and 127 on 
the ASCII standard code page are valid. Other characters are not supported and causes 
unpredictable behavior for attribute (GSA) data. Examples are:

• Spanish n with tilde: ñ
• Long Dash: -
• Reverse Quote: '
• Copyright: ©
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Address Coding
Your Address Coding license covers a state, a region, or whole country. The license file that 
ships with Centrus Desktop informs the system which areas are available for coding. If 
there are addresses outside of the coverage area in a file being processed, Centrus 
Desktop flags these addresses with a match code indicating an out-of-coverage address.

Note: For best results, Precisely recommends that you enter addresses into address files 
following the USPS guidelines outlined in Publication 28, Postal Addressing 
Standards, which is available free of charge from the USPS.

When Centrus Desktop processes an address file, it standardizes each address to USPS or 
CPC standards. To cleanse your addresses and help ensure deliverability, you may choose 
to have the standardized output returned. The differences between USPS and CPC 
processing are:

• Centrus Desktop geocodes U.S. addresses to either the address or ZIP + 4 level.
– If the address is in the USPS files, the address is standardized with a ZIP + 4 (and 

all other USPS information). If the address is also in the street network files, Centrus 
Desktop determines an accurate latitude and longitude for the location.

– If the address is not in the enhanced street network files, location and census 
information is then taken from the ZIP + 4, ZIP + 2, or ZIP Code centroid.

• To standardize Canadian addresses, Address Coding compares street addresses from 
the address file to records in the CPC data files. Address-level geocoding is not 
available for Canadian addresses.

Standardization and geocoding success rates depend upon the quality of the addresses in 
your file. Centrus Desktop can correct minor misspellings, and missing or incorrect 
directionals, street types, and ZIP Codes. If an address has an incorrect street number, or if 
the address contains a number of errors, Centrus Desktop may not be able to make a 
successful match.

See the following sections for more information on processing:

• U.S. address processing

• Canadian address processing

• Z4 Change Processing

• Address line two preferences

U.S. address processing
When you select United States on the Process Options dialog box, the Address Coding 
module:

• Standardizes, corrects, and appends information about your addresses.
• Standardizes addresses to USPS standards, which reduces mailing costs and 

increases delivery speed by supplying correct USPS information. The Address Coding 
Module also identifies poorly formed or undeliverable addresses.

• Produces a USPS CASS report, for greater postage savings.
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• Assigns Latitude, Longitude, and Census ID information to the block level.
• Assigns a geocode when address geocoding is unavailable. ZIP + 4 centroids return 

Census ID information to the Block Group level using ZIP + 4 centroid geocoding.

Canadian address processing
When you select Canada on the Process Options dialog box, the Address Coding module:

• Standardizes, corrects, and appends information about your addresses
• Produces a Canadian Post Corporation (CPC) SERP report
• Performs Postal Code-level geocoding

Z4 Change Processing
Z4 Change Processing greatly enhances processing speed when you are using large 
databases that require frequent reprocessing. Z4 Change Processing uses USPS data that 
details which records have changed in the past 12 months. Centrus Desktop looks at the 
last date on which a particular list was processed, and compares each address to a Z4 
Change Directory to see if it has changed in any way. Then, it reprocesses only those 
addresses which have changed, rather than the entire database—making processing 
speed significantly faster than using Address Coding alone.

The Us.gsl file contains the data required for Z4 Change Processing. This file must be 
located in the default search path.

Note: This option does not affect Canadian processing.

Address line two preferences
Address line two allows you to pass two different address lines to Centrus Desktop. The 
software then scans the two lines, and extracts and standardizes a two-line address, if 
possible. You can set Centrus Desktop to accept a P.O. Box or a street address as the 
preferred address. If you do not specify an option, or the two lines contain similar 
information, Centrus Desktop prefers line one.

Note: This option does not affect Canadian processing.

City-only lastline matching
City-only lastline matching permits address matching with only a city in the input lastline. 
The input address should be provided using the Standard rather than the Multiline input 
fields.

With city-only lastline input, the search engine will search all of the states in which the input 
city exists. Therefore, there is the possibility of an increase in multi-matches (E023 and 
E030) when matching with city-only input instead of city+state lastline input.
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Restrictions:
• City-only lastline input matching is not supported in CASS mode.
• City-only lastline is not supported when matching to User Dictionaries.
• When matching using city-only lastline, the ‘Prefer Input ZIP over Input city’ US Address 

Coding setting is ignored.
• It is strongly recommended to not use city-only lastline matching in Relaxed mode to 

avoid the return of false-positive matches.

Creating an Address Coding task
Once you have configured Centrus Desktop for your system, you can set up your tasks. 
The tabs on the Centrus Desktop main window represent each Centrus Desktop 
component, as well as a Tables tab for specifying input and output files and tables. Each 
component’s tab allows you to define how you want that module to process your data. 
Collectively, these settings constitute a task. Tasks are to Centrus Desktop what documents 
are to your word processing software. You can create them, save them, edit them, and 
rename them.

Note: By default, Centrus Desktop stores your tasks stored in the Centrus Desktop 
program directory. Task files must have the extension .qmi. If you wish to overwrite 
the default settings, overwrite the file Centrus Desktop.qmi, located in your 
Windows directory, with your own task file.

To create an Address Coding task:

1. From the Tables tab, click Browse from the Input field.

2. When the Select a file window opens, select a file to process and click Open.

Note: The In-Place Update option allows you to write your output directly to your input 
file. This is not recommended.

3. Click Browse from the Output field.

4. When the Select Output File window opens, select a file and click Save.

5. Decide whether to use the Reject Records That Are Not: section. If selected, chose 
any of the options below and click Browse from the Rejects field.

6. When the Select Output File window opens, select a file and click Save.

7. Decide whether to use the Report Files section. If selected, click Browse from the 
Audit field. 

8. Change the Frequency if necessary.

9. Change the Log Output if necessary by clicking Browse. 

• When the Select Log Destination File window opens, select a file and click Save.

10. You can also select whether to View log file when processing is complete.
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11. Save task by either selecting File > Save Task or Save Task As from the menu, or the 
 icon from the toolbar.

• The Address Coding tab is now populated, see Understanding the Address Coding tab for 
more information.

12. You now need to edit the Address Coding options, see Setting Address Coding options for 
more information.

13. You can now process the task by selecting Process > Process Task or Batch 
Process Task from the menu, or by clicking the  icon from the toolbar.

14. When the Process window opens, click Next Error or Batch.

15. Click Done.

16. You can now view the output log, if selected.

Understanding the Address Coding tab
To better understand the Address Coding tab see the following table which describes the 
options available.

Option Description

Define Input Fields

Standard Once you have selected a file to process, Centrus Desktop populates the input 
fields based on the input file’s field names. If Centrus Desktop did not populate 
an input field, or did not populate it with the correct field, click the drop-down 
arrows to select from the available address file fields. 
To remove a field, select the special field <none> at the top of the list box of 
input field names.

NOTE: If you are using Z4 Change Processing, you must select address file 
fields for ZIP Code and ZIP + 4.

Using different input formats
In many files, the address information is contained in discrete fields that 
correspond to Firm, Address, City, State, ZIP Code, and possibly ZIP + 4 or 
Country. 
Some files, however, do not have discrete fields for last line information (City, 
State, and ZIP). You can assign the field containing the Last Line information 
to the City input field.



 

Centrus Desktop User Guide for Windows 28

Multiline Select the Multiline Input check box and the field identifiers for the input Fields 
change to Line 1 through Line 6, and the Optimization Sort check box 
disappears. When using this option, you may specify any six fields that Centrus 
Desktop should search through in order to find an address. Centrus Desktop 
can determine, for each record, which fields contain address information, and 
which fields do not. Fields containing no address information are ignored.
You should specify fields in logical address order. You should list fields that 
could contain the street address information before fields that could contain 
last-line information (city, state, and ZIP).
For example, Centrus Desktop can handle the following address:
Attn. Product Management
Precisely
4750 Walnut St.
Ste 200
Boulder, CO 80301
but not the following address:
The Private Mail Box Designator and Private Mail Box Number output address 
elements are not available when using the Multiline Input option.

NOTE: This option does not affect Canadian processing.

The following are guidelines for using multiline mode:
• You can specify from two to six input fields. Note that the Address Coding 

module cannot detect the address and last line information when all of the 
information is in one field.

• Firm names should appear before the street address line.
• You can list suite or apartment numbers on, above, or below the street 

address line. However, they must appear before the last line information.
• Last line information must come after the street address information. You 

can specify different input fields for City, State, and ZIP Code, but you must 
list them in that order.

Processing Parameters

Process if Unmatched or Field is 
Blank

Allows you to process only those records with missing data in a particular field, 
which you specify using the drop-down list. This is useful for cleaning up a 
previously processed database.
This option is ignored, and the record is processed if any of the following critical 
match fields are missing or empty:
•   Latitude
•   Longitude
•   Location Code
•   Match Code
This option is ignored and the record is processed if any of the following critical 
match fields begins with an "E".
•   Location Code
•   Match Code

NOTE: This option is disabled when producing a CASS report—Centrus 
Desktop must process all records for CASS compliance.

Optimization Sort Causes Centrus Desktop to process the file in ZIP Code sequence. In most 
cases, this significantly speeds processing. Optimization Sort requires a ZIP 
input field, and is limited to processing non-text files.

Assign Outputs

Option Description
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Common elements in standardization
Centrus Desktop can automatically assign the most commonly-used address 
standardization data elements to their corresponding field names, or create new fields for 
these data elements. From the main menu, select Edit, then Standardization Defaults. 
Select Existing Fields to have Centrus Desktop attempt to assign the standardization 
defaults to your existing fields. Select New Fields to create new fields for any 
standardization defaults you have not yet assigned. The standardization default data 
elements are as follows:

• Firm Name
• Address Line
• Last Line
• Delivery Point Barcode
• Check Digit
• Carrier Route

Output Assignment Associates address data elements with output field names. By default, the list 
of field names is the same as the input fields in the Define Input Fields section 
of the dialog box. You can assign address data elements to existing field 
names, or create new fields to receive the data.

NOTE: If you are using Z4 Change Processing, be sure to select the 
Z4ChangeResult address element in this dialog box.

By default, outputs are ordered alphabetically by field name. Click Output 
Assignment to view outputs ordered alphabetically by output assignment.

Address Elements To associate a data element with an output field:
1. Select a field name.
2. Select the desired data element.
3. Click Assign.
The selected element appears in the Output Assignment column next to the 
field name to which it is assigned. An A icon appears before the element, 
signifying that the data is assigned to an output field.

To create a new field:
1. Click the data element you wish to assign.
2. Click New. The New Field dialog box appears.
3. Specify the name, type, width, and (if numeric) decimal places desired, or 
click OK to accept the default values.
The selected element appears in the Output Assignment column next to the 
field name to which it is assigned. An “A” icon appears before the address 
element, signifying that the data is assigned to your new output field.
If the currently selected field is an input field, click Unassign to remove its 
output assignment. If the currently selected field is a new field, click Unassign 
to delete it.
You may unassign an output assignment from any tab.

Blank if Unmatched Clears all output fields defined within the module if Centrus Desktop cannot 
match the record.

Option Description
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• Urbanization (Puerto Rico)
• Match Code

Common elements in geocode data
Centrus Desktop can automatically assign the most commonly used geocode data 
elements to their corresponding field names, or create new fields for these data elements. 
From the main menu, select Edit, then Geocode Defaults. Select Existing Fields to have 
Centrus Desktop attempt to assign the standardization defaults to your existing fields. 
Select New Fields to create new fields for any geocode defaults you have not yet assigned. 
The geocode default data elements are:

• Latitude
• Longitude
• Match Code
• Location Code
• Census Block Group (12 Digits)

Note: This option does not affect Canadian processing.

Available elements
This section details all information about the address data available within Address Coding. 
The following table lists each address element with the maximum length of the information 
returned, as well as a description of the element.

The following table describes the available output elements. 

Address element Size Description

Address Line 255 Full address line (e.g., 1920 MAIN ST W APT 12).

Address Line 2 60 Second address line (e.g., Suite 200).

Address Type 2 Address Type regarding number of units:
• S – Single unit
• M – Multiple units
• P – Post Office box
• X –Unknown

NOTE: This field is only available with the MLD Extended Attributes 
Dataset

APN ID 45 Assessor’s Parcel Number.

Aux User Data 300 User data from the auxiliary file. Blank if no file.

Carrier Route Sortation 1 Indicates whether a discount is provided for letter-sized carrier route sorted 
mail in current ZIP Code.

Carrier Route 4 Carrier Route ID number.

CBSA Division Name 127 CBSA division name.
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CBSA Division Number 5 CBSA division number.

CBSA Name 127 CBSA name.

CBSA Number 5 CBSA number.

CSA Name 127 CSA name.

CSA Number 3 CSA number.

Census Block 15 Full block code.

Census Block 3 Block code only.

Census Block Group 1 Block Group code only.

Census Block Group 12 Full Block Group code.

Census Block Suffix 1 Centrus Block Suffix.

Census Tract 11 Full Census Tract code.

Census Tract 6 Census Tract code only.

Check Digit 1 Used with the DPBC to ensure that the bar code printed on the mailing 
piece is correct.

City Delivery 1 Indicates whether a Post Office has city-delivery carrier routes.

City Name 28 Valid USPS city name (such as BOULDER).

City State Record Name 28 City name for the matched address from the City State record.

CMSA Name 80 Consolidated Metropolitan Statistical Area name.

CMSA Number 4 Consolidated Metropolitan Statistical Area number.

Country 128 Country name.

County FIPS Code 3 County code only (e.g., 013).

County FIPS Code 5 Full state and county code (e.g., 08013).

County Name 128 County name.

Address element Size Description
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Data Type 3 The type of data used to make the match:
• 0  - USPS data.
• 1 - TIGER data.
• 2  - TomTom data.
• 3  - Sanborn point-level data.
• 4  - Deprecated
• 5  - Deprecated
• 6  - NAVTEQ data.
• 7  - TomTom point-level data.
• 8 - Centrus point-level data
• 9 - Auxiliary file data
• 10 - User dictionary
• 11 - NAVTEQ point-level data
• 12 - Master Location Data

Default Match 1 Contains one of the following values: 
• Y - Either High-Rise Default or Rural Route Default returned Y.
• Blank - Both High-Rise Default and Rural Route Default returned N or 

Blank.

Delivery Point Barcode 2 A two-digit field that, when appended to the end of the 9-digit ZIP + 4 Code, 
creates the Delivery Point Bar Code, which is then printed in the address 
section on the mailing piece to assist with automated sorting.

DPV Confirmation Indicator 1 DPV confirmation indicator.

DPV CMRA Indicator 1 DPV CMRA indicator.

DPV False Positive 
Indicator 

1 Indicates if Centrus Desktop found a false-positive match.

DPV Footnote 1 2 Contains information about matched DPV records:
• AA - ZIP + 4 matched record 
• A1 - For failure to match a ZIP + 4 record.
• Blank - Address not presented to hash table or DPV data not loaded.

DPV Footnote 2 2 Contains information about matched DPV records:
• BB - All DPV categories matched.
• CC - Matched primary/house number, but secondary/unit number did 

not match.
• M1 - Missing primary/house number.
• M3 - Invalid primary/house number.
• N1 - Matched primary/house number, but missing high rise secondary 

number.
• P1 - Missing PS, RR, or HC Box number.
• P3 - Invalid PS, RR or HC Box number.
• F1 - All military addresses.
• G1 - All general delivery addresses.
• U1 - All unique ZIP Code addresses.
• Blank - Address not presented to hash table or DPV data not loaded.

Address element Size Description
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DPV Footnote 3 2 Contains information about matched DPV records:
• R1 - Matched CMRA, without a present secondary/unit number.
• RR - Matched CMRA blank for address not presented to hash table or 

DPV data not loaded.

DPV No Stat 1 CDS pre-processing.

DPV Vacant 1 The DPV Vacant Table contains delivery points that were active in the past 
but are currently vacant and in the majority of cases unoccupied for over 
90 days and not receiving mail delivery.

EWS Match 1 Contains a letter indicating whether the record matched to EWS data: 
• Y - match denied because it matched to EWS data.
• Blank - input record did not match to EWS data.

Extra Line 1-6 103 Used to capture data contained in unassigned address lines

Extra/Mail Stop 60 Contains address information appearing after mail stop designator words: 
MSC, MS, MAILSTOP, MAIL STOP, ATTN, ATTENTION

Firm Name 40 Firm name, as known by the USPS or CPC, or as entered; blank if the 
USPS or CPC does not know what firm is at that location

High Rise Default 1 Contains information on high-rise records:
• N - Matched to an exact high rise record or a street record.
• Y - Exact record not found. Matched to the USPS default high rise 

record or a street record. The input address should be checked for 
accuracy and completeness.

• Blank - Flag does not apply to the input address (e.g., P.O. Boxes and 
General Delivery addresses) or no match was found.

Incorporated Place 
Indicator 

2 Incorporated Place Indicator: 
• I - Incorporated place
• N - Not an incorporated place
• X - Unknown

NOTE: This field is only available with the MLD Extended Attributes 
Dataset

Intersection Flag 1 T if an intersection match was made, or F if a normal address match was 
made.

LACSLink Indicator 1 LACSLink indicator.

LACSLink Return Code 2 LACSLink return code.

LACS Status 1 Locatable Address Conversion Service Status Indicator: 
• L - old (usually rural route) address converted for the LACS system
• Blank - Not applicable

Last Line 60 Full last line (e.g., BOULDER CO 80301-1234).

Latitude 10 Latitude coordinate in decimal degrees to 6 decimal places (such as 
123.234234).

NOTE: Latitude and Longitude must be used together, or not at all.

Address element Size Description
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Location Code 4 Locational accuracy of the match. See “Location codes” on page 75 for 
details.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset

Longitude 11 Longitude coordinate in decimal degrees to 6 decimal places (such as 
123.234234). The number is positive or negative depending on the setting 
of the Negate Longitudes check box in the Options dialog box.

NOTE: Latitude and Longitude must be used together, or not at all.

LOT (Line of Travel) 
Number 

4 Numeric LOT code used for presort.

LOT Direction Flag 4 LOT direction: 
• A - Ascending 
• D - Descending

Lot Size of Parcel 11 Lot size of the parcel expressed in square meters; 0 if none.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

Match Code 4 Components of an address that were modified for a successful match. If a 
match was not successful, explains why the match could not be made. See 
“Match codes” on page 65 for details.
This field is only available with the MLD Extended Attributes Dataset.

MCD Name 40 Minor Civil Division name from the auxiliary file. Blank if no auxiliary file 
match.

MCD Number 5 Minor Civil Division number form the auxiliary file. Blank if no auxiliary file 
match.

MEC Latitude 13 Latitude of Minimum Enclosing Circle (MEC) expressed with an implied 6 
digits of decimal precision; 0 if none. For example: 34809676 means 
34.809676.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

MEC Longitude 13 Longitude of Minimum Enclosing Circle expressed with an implied 6 digits 
of decimal precision; 0 if none. For example: -92447089 means -
92.447089.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

MEC Radius 12 Radius of Minimum Enclosing Circle (in square feet) expressed as a whole 
number. For example: 1234 means 1,234 square feet.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

Metro/Micropolitan Flag 1 Metropolitan or micropolitan flag.

MSA Name 65 Metropolitan Statistical Area name.

MSA Number 4 Metropolitan Statistical Area FIPS number.

Parcel Centroid Elevation 7 Parcel centroid elevation.

Address element Size Description
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pbKey 13 A unique address identifier returned when an address match is returned 
from the Master Location Dataset. The leading character is a ‘P’. For 
example: P00001XSF1IF

Postal Code 10 Canadian postal code.

Preferred City Name 28 Preferred city name for the output ZIP Code of the matched address.

Primary Post-Directional 2 Post-directional (such as E).

Primary Pre-Directional 2 Pre-directional (such as NW).

Primary Short Post-
Directional

2 Shortest possible post-directional determined by CASS rules.

Primary Short Pre-
Directional

2 Shortest possible pre-directional determined by CASS rules.

Primary Short Street Name 2 Shortest possible street name determined by CASS rules.

Primary Short Street Suffix 2 Shortest possible street suffix determined by CASS rules.

Primary Street Name 40 Street name (such as MAIN).

Primary Street Suffix 4 Street suffix, or type (such as ST).

Private Mail Box (PMB) 
Designator

4 Private mail box designator.

Private Mail Box (PMB) 
Number

8 Private mail box number.

Point ID 10 Unique point ID of the matched record when matched to point-level data. 
Blank if the matched record is not from point-level data.

Range Record Type 1 For non-intersection matches, a letter denoting the USPS Range type, 
where: 
• G - General delivery record
• H - High-rise record
• F - Firm record
• S - Street record
• P - P.O. Box record
• R - Rural route/highway contract record

RDI Return Code 1 Residential Delivery Indicator (RDI):
• Y = Residence
• N = Business
• Blank = Not processed through RDI

Residential or Business 
Indicator 

2 Usage indicator: 
• R - Residential use
• B - Business use
• M - Mixed use – residential and business
• X - Unknown use

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

Address element Size Description
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Rural Route Default 1 Contains one of the following values:
• N - Matched to an exact rural route record.
• Y - Exact record not found. Matched to USPS default rural route record. 

The input address should be checked for accuracy and completeness.
• Blank - Does not apply to the input address (for example, PO Boxes and 

General Delivery addresses) or no match was found.

Secondary Post-Directional 2 Second post directional.

Secondary Pre-Directional 2 Second pre-directional.

Secondary Short Street 
Name

2 Second shortest possible street name determined by CASS rules.

Secondary Short Street 
Suffix

2 Second shortest possible street suffix determined by CASS rules.

Secondary Short Post-
Directional

2 Second shortest possible post-directional determined by CASS rules.

Secondary Short Pre-
Directional 

2 Second shortest possible pre-directional determined by CASS rules.

Secondary Street Name 40 Second street name.

Secondary Street Suffix 4 Second street suffix or type.

Segment ID 10 Segment ID.

Short Address Line 60 Shortest possible address determined by CASS rules.

Short Last Line 60 Short city name, state, and 10-digit zip determined by CASS rules.

Short City Name 28 City name, 13 characters or less whenever possible determined by CASS 
rules.

SuiteLink Return Code 2 SuiteLink return code.

State Abbreviation 2 2-letter state (or Province) abbreviation.

State FIPS Code 2 State code.

TIGER Face ID TIGER Face Identifier (TFID). This field can be used to match to all Census 
geocodes using external data; 0 if none.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

TIGER Place Code 8 TIGER Place code; 0 if none.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

TIGER Urban Area ID 
(UACE) 

6 TIGER Urban Area Identifier. Defines the urban area if any; 0,if none.

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

Unit Designator 4 Unit designator (such as STE).

Unit Designator 2 4 Second unit designator parsed from the address line, supported only in 
CASS mode.

Address element Size Description
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Unit Number 11 Unit or apartment number (such as 2A).

Unit Number 2 11 Second unit number parsed from the address line, supported only in CASS 
mode.

Urban Area Population 11 Census population of the urban area; 0 if none.

Urbanicity Indicator 2 Defines, per the Census, the Urbanicity of the address using TIGER UACE 
codes for categorization.
• L – Large Urban Area (50,000 or greater population)
• S – Small Urban Area (2,500-50,000 population)
• R   – Rural
• X – Unknown

NOTE: This field is only available with the MLD Extended Attributes 
Dataset.

Urbanization 30 Urbanization code for the address, used for Puerto Rican addresses only.

Z4ChangeResult 2 One of the following values:
• N - No changes. Your address records match the current USPS Z4 

data. 
• Y - Changes to current USPS Z4 data. Re-standardize your address 

records.

ZIP Classification 1 Describes the type of area that a 5-digit ZIP Code serves: 
• M - Military ZIP Code.
• P - P.O. Boxes only.
• U - Unique ZIP Code (single organization).
• Blank - standard ZIP Code.

ZIP Code 5 ZIP Code (e.g., 80301) address elements for U.S. and Canadian 
addresses.

ZIP Facility 1 USPS City State Name Facility Code:
• A - Airport Mail Facility (AMF).
• B - Branch.
• C - Community Post Office (CPO).
• D - Area Distribution Center (ADC).
• E - Sectional Center Facility (SCF).
• F - Delivery Distribution Center (DDC). 
• G - General Mail Facility (GMF). 
• K - Bulk Mail Center (BMC). 
• M - Money Order Unit. 
• N - Non-postal community name.
• P - Post Office. 
• S - Station. 
• U - Urbanization.

ZIP+4 Extension 4 ZIP + 4 trailing code (in the case of 80301-1234, the extension is 1234).

ZIP10 10 Complete ZIP + 4 with hyphen (such as 80301-1234).

ZIP9 9 Complete ZIP + 4 (such as 803011234).

Address element Size Description
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Latitude and Longitude must be used together, or not at all.

In an xBASE file, if the fields for Latitude and Longitude are numeric and have 0 decimal 
places, Latitude and Longitude are returned in millionths of degrees. ASCII files always 
receive decimal degrees.

Setting Address Coding options
1. To set the options for an existing task, open the task, if not already open. Do this by 

either selecting File > Open Task from the menu or by clicking the   icon from the 

toolbar.

2. Open the Option window by either selecting Process > Options from the menu, or the 
 icon from the toolbar.

3. When the Options window opens, from the Address Coding Options tab, select the 
appropriate options as detailed below:

Option Description

Country

United States Performs standard or multiline processing using selected U.S. Geocoding and 
U.S. Address Coding options.

Canada Performs standard processing only.

Automatic Determines if the address is U.S. or Canadian and processes it accordingly.

US Geocoding Options

Address Matching/
Matching Tolerance

• Tight - Requires that you have already standardized your addresses to USPS 
standards. This is the fastest option.

• Close (default) - Recommended for most uses. It allows minor misspellings, 
as well as incorrect or missing directionals or street types in the input 
addresses.

• Extended - Is similar to Close, except that the street name search looks at all 
streets that have the same first letter, rather than using pattern matching. This 
setting also performs the widest search possible, using the USPS Finance 
Area. You should review all matches made by this setting where Centrus 
Desktop modified the street name. You can identify these matches using the 
Match Code. (For more information, see “Match codes” on page 65.) This is 
the slowest setting.

• CASS - Uses the USPS rules to obtain a match and produces a CASS report. 
With this setting, some addresses that could be successfully coded using the 
Close or Extended settings may not be successfully matched.

• GeoStan™ Close Mode - Corresponds to GeoStan Close mode.
• Interactive - For single-line address matching only. Permits more flexible 

matching patterns and may, in some cases, return additional possible 
matches than the other modes.

NOTE: Matching Tolerance does not affect Canadian processing.
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ZIP Centroid 
Matching/ Minimum 
Quality

• 9 Digit Best Location - Uses the most positionally accurate 9-digit centroids. 
These centroids are almost as accurate as an address geocode, in that they 
are usually accurate to a single block face. Census accuracy varies, but most 
centroids in this class are accurate to the Block Group level.

• 9 Digit Good Location - Uses 9-digit centroids with very good positional 
accuracy. These centroids are usually accurate to a single block face. Census 
accuracy varies, but most centroids in this class are accurate to the Block 
Group or Census Tract level.

• 9 or 7 Digit Location - Uses all 9- or 7-digit centroids. A 7-digit centroid is 
positionally accurate to within several blocks in most areas. Census accuracy 
varies. This setting yields all but 5-digit centroids.

• Block Group Accuracy - Uses centroids that are accurate to the Block Group 
level. Positional accuracy varies, but is normally accurate to the city block on 
which the address is located.

• Census Tract Accuracy - Uses centroids that are accurate to the Census Tract 
level or better. Positional accuracy varies, but is normally accurate to within 
several city blocks of the address.

• 5 Digit Only - Uses only 5-digit centroids. This is the least accurate geocode, 
but it is the fastest to assign.

• Best Centroid (default) - Uses the best centroid, but all centroids are available.
See Location codes for a complete listing of the location codes and settings 
assigned to each centroid type.

NOTE: This option does not affect Canadian processing.

Street Centroid 
Matching

When you select the Street Centroid Matching checkbox, if a street name is 
encountered while geocoding, and there is no matching address range, Centrus 
Desktop will attempt to locate the street within the input ZIP Code or city if there 
is no input ZIP Code. If Centrus Desktop is able to locate the street, it will return 
a geocode along the matched street segment rather than the geocode for the 
entered ZIP Code or ZIP + 4.
If a street number is entered, Centrus Desktop will return the coordinates of the 
end point of the closest numeric street segment within the input ZIP Code. When 
there is no input Zip Code, the closest numeric street segment of all the Zip 
Codes within the input city will be returned. 
If no street number is entered, the centroid of a street segment within the input 
Zip Code will be returned. The centroid of a street segment for all the Zip Codes 
within the input city will be returned when there is no input Zip Code. 
See Location codes for a complete listing of the location codes and settings 
assigned to each centroid type.

NOTE: This option is not available in the CASS Address Matching processing 
mode, and it does not affect Canadian processing.

City Centroid 
Fallback

Allows for an automatic fallback to a city centroid geocode if no match is found 
and the input ZIP Code is missing or incorrect.  Although geographic centroid 
geocoding is less precise than street or postal geocoding, it may be suitable for 
certain applications.

Census ID Format • Delimited - 08 013 0002.01-1
• Census - 080130002.011
• Digits only - 080130002011

NOTE: This option does not affect Canadian processing.

Finance Area Search A search within a finance area, which is a collection of ZIP Codes within a 
contiguous geographic region.

Option Description
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Negate Longitudes When you select the Negate Longitudes checkbox (the default), Centrus 
Desktop returns longitudes as negative numbers for Western hemisphere 
locations. When you clear the checkbox, Centrus Desktop returns longitudes as 
positive numbers. Latitudes are always returned as positive numbers.
This option is available for those applications that require positive longitudes. 
Most mapping and GIS applications today use negative longitudes for western 
hemisphere locations. 

NOTE: This option does not affect Canadian processing.

Allow 5-Digit ZIP 
Code Census 
Centroid ID

When selected, this checkbox permits the assignment of the Census FIPS Code 
even when only 5-digit ZIP Code centroids are available. The default setting for 
this checkbox is cleared (not selected).

NOTE: This option does not affect Canadian processing.

Use Address Point 
Interpolation

Address point interpolation uses a patented process that improves upon regular 
street segment interpolation by inserting point data into the interpolation process.

Return coordinates 
in...

• NAD 27 - This has its origin at Meades Ranch, Kansas. NAD27 does not 
include the Alaskan islands and Hawaii. Latitudes and longitudes that are 
surveyed in the NAD27 system are valid only in reference to NAD27 and do 
not tie to any maps outside the U.S.

• NAD 83 - This is earth-centered and defined with satellite and terrestrial data. 
NAD83 is compatible with the World Geodetic System 1984 (WGS84), the 
terrestrial reference frame associated with the NAVSTAR Global Positioning 
System (GPS) now used extensively for navigation and surveying.

• Offset/Backset - This option moves the geocoded address in the desired 
number of feet off the center of the street. The default is 50 feet for the best 
visual representation for mapping. 

US Address Coding Options

Address Line Two 
Preference

Two-line addressing allows your input addresses to have two address lines. 
Centrus Desktop scans these two lines and extracts and standardizes a two-line 
address, if possible. You can set Centrus Desktop to accept a P.O. Box or a 
street address as the preferred returned address. If you do not specify an option, 
or if the two lines contain similar information, Centrus Desktop uses line one of 
the input.
If a unit designator is present on one address line and a valid address appears 
on the other line, the unit information is appended to the address.

NOTE: This option does not affect Canadian processing.

Firm Name Lookup You can match to the input firm name, or business name, rather than an address. 
Firm or business name must be in the Firm name input field.
Preferences:
• Disabled - This feature is off.
• Prefer Street Name - Matches to the address line, if a match is not made, then 

a match is attempted to the Firm name line.
• Prefer Firm Name - Matches to the Firm name line, if a match is not made, 

then a match is attempted to the address line.
• Street Lookup Only - Matches to the address line.

Enhanced Building 
Search

When selected, the Enhanced Building Search checkbox enables you to 
match to the default range record for a building name entered in the input 
address line rather than an address. An input unit number for the building is not 
required. The default setting for this checkbox is cleared (not selected). This 
option does not function in CASS mode.

NOTE: This option does not affect Canadian processing.

Option Description
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Prefer Input ZIP over 
Input city

This setting allows a user to prefer a match based on the input ZIP Code rather 
than the input city. In the case where the input ZIP Code and city do not agree, 
the city name will be changed if a match is made to the input ZIP Code. If no 
match is made to the input ZIP Code, a match can still be made to the input city 
if one exists.

Check for First Letter 
Missing/Wrong

The first letter missing/ wrong feature enables Desktop to look for the correct first 
letter of a street address if the first letter is missing or incorrect. Desktop 
searches through the alphabet looking for possible, correct first letters to 
complete the street address. 

Allow Ranged 
Address Numbers

This feature allows a search for address ranges. Some business locations are 
identified by address ranges. For example, a shopping plaza could be addressed 
as 10-12 Front St. This is how business mail is typically addressed to such a 
business location. These address ranges can be geocoded to the presumed mid-
point of the range.

Mixed Case Output 
Addresses

If you select the Mixed Case Output Addresses checkbox, Centrus Desktop 
returns addresses with the first letter of each word capitalized.
Normally, Centrus Desktop returns addresses in uppercase letters, according to 
USPS and Canada Post Corporation (CPC) recommendations. 

Output Corrected 
Last Line

This feature, when enabled, corrects elements of the output last line, providing a 
good ZIP Code or close match on the soundex even if the address would not 
match or was non-existent.

Z4 Change 
Processing

Controls ZIP + 4 change processing, enabling you to update addresses whose 
ZIP + 4 codes have changed.
Enter the date (such as 12/2006) that the list records were last processed in the 
“Last Process Month/Year” text box. Once Z4 Change Processing is activated, 
only records that have changed since the last time the list was processed are re-
processed.
See “Z4 Change Processing” on page 25 for an explanation of this feature.

NOTE: This option does not affect Canadian processing.

Postal Reports

Produce Canada 
Post SERP Report

When the selected, Centrus Desktop produces a text file containing the report 
information. Specify the name and location of this file by clicking Browse and 
entering the path and name in the file selection dialog box.
The View checkbox allows you to display the SERP report in a text editor when 
processing is complete.
If not selected, the SERP report does not display. This is a useful option for 
processing in batch mode.

Option Description
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Data Viewer
The Data Viewer enables you to view the contents of the current input file, one record at a 
time.

To use Data Viewer:

1. Click Data Viewer or select Tools > Data Viewer.

Field names are shown in the left column of the Data Viewer dialog box; field values 
appear in the right column. 

2. Click the arrow buttons to navigate forwards and backwards through the file.

3. You can also type a record number into the text box and click Go to view a particular 
record.
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Understanding Closest Site
Closest Site analysis is a distance test between two sets of points. Closest Site calculations 
return the distance from the address to the site point, as well as the name of that site point.

Closest Site requires geocoded addresses with Latitude/Longitude coordinates as input. To 
geocode the addresses in your files, we recommend that you use Address Coding, for the 
quickest, most accurate geocode assignments. You can even geocode and perform spatial 
analyses in the same task.

The available spatial outputs are determined by the contents of the object files or layers you 
have specified in the Process Options dialog box. Geographic features (points, lines, or 
polygons) are imported into the native Centrus Desktop format. To import your data into the 
.gsb format, Centrus Desktop is able to import most popular third-party data formats.

GIS applications separate the different types of information into data “layers.” For example, 
store locations might be defined in on one layer and main roads on another.

Use the Closest Site tab to determine which data layers are available to the Closest Site 
module. You can add data layers that are already in .gsb format, such as the States.gsb and 
Counties.gsb files. You can also import layers from third-party data providers.

Understanding Point-in-Polygon
Point-in-Polygon allows you to determine whether or not a given geocoded point lies inside 
a polygon drawn on a map.

The buffer zone around the polygon is defined, allowing you to determine if the point lies 
well within the boundary, near to the boundary but inside it, near to the boundary but outside 
it, or well outside the boundary. 

GIS applications separate the different types of information into data “layers.” For example, 
store locations might be defined in on one layer and main roads on another.

Use the Point-in-Polygon tab to determine which data layers are available to the Point-in-
Polygon module. You can add data layers that are already in .gsb format, such as the 
States.gsb and Counties.gsb files. You can also import layers from third-party data 
providers.

Note: You can only use data layers built with buffers enabled for use with the Point-in-
Polygon function.

Creating a Closest Site and Point-in-Polygon task
Closest Site analysis compares the geocoded addresses (or other points) in your input file 
to a geocoded site layer you specify in the Closest Site options tab. Centrus Desktop can 
identify the closest sites for each point in the input file, and return the site’s identifier and the 
straight-line distance to the site for each site found.
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To create a new task:

1. Select the Closest Site tab, and click Configure.

2. Select Process > Options > Closest Site tab from the menu, or the   icon from the 
toolbar.

3. When the Process Options window opens, click Add GSB.

4. When the Select Layers window opens, select the appropriate file and click Open.

5. From the Process Options window, select the Point-in-Polygon tab.

6. When the Select Layers window opens, select the appropriate file and click Open.

7. Select the appropriate input options for Latitude and Longitude.

The options for Latitude and Longitude are the same as the Field Name under Assign 
Outputs.

The options under Field Name correspond to your input data when creating the task.

8. Select the necessary outputs from the Available Outputs field, and click Assign or 
New. See the following table for more information on the output options.

Note: For more information on inputs and outputs, see Data file reference.

9. You can now process the task by selecting Process > Process Task or Batch 
Process Task from the menu, or by clicking the  icon from the toolbar.

Available outputs Description

Closest Site

Name Name of the feature as it is defined in the layer.

Distance Distance from the address to the closest site in the layer. The GSB file must be 
built with buffering enabled to return a distance value.

Direction Direction from the address to the closest site in the layer, measured in degrees, 
with north at 0/360 degrees.

Point-in-Polygon

Status Defines where an address lies in relation to the polygon. Status codes are: 
• P in polygon
• E Edge; in buffer, inside polygon 
• B In buffer, outside polygon 
• N Not found 
Refer to “Point-in-Polygon analysis” on page 50 for an illustration of the status 
codes.

Distance The distance from the address to the edge of the polygon. The GSB file must 
be built with buffering enabled to return a distance value.

Name The name of the feature as it is defined in the layer.
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10. When the Process window opens, click Next Error or Batch.

11. Click Done.

Importing Closest Site or Point-in-Polygon layers
To import third-party layer files:

1. Select Process > Options from the menu or the   icon from the toolbar.

2. Select either the Closest Site or the Point-in-Polygon tab.

The following steps apply to either chosen tab.

3. Click Import.

4. When the Importer window opens, click Browse to select the path and name of the file 
to import.

To determine which field is used as the object’s identifier, click the Identifier Field drop-
down list box.

5. Click Browse on the Output area of the dialog box to select the object file (.gsb) to 
create.

6. Verify that the Enable Buffering checkbox is selected. If this checkbox is not selected, 
you do not receive in-border or in-buffer polygon locations and distance-to-border 
values.

To create attributes to receive more information about the points, select the Create 
Spatial Attributes checkbox. If the input file is a proprietary shape file, the file must be 
a .shp or .tab file. If the input is a table file, the type must be delimited, text, .dbf, or 
.mdb. 

Note: For more information on Spatial attributes, see Spatial attributes.

7. Click Import.

8. Click OK.

The Available Outputs selection box is populated with the standard Name, Distance, 
and Direction attributes, as well as the fields contained in your import file (if you 
imported Spatial attributes). You can now assign any of these fields as output fields.

Note: While Western-hemisphere locations are correctly expressed as negative 
longitudes, some mapping and GIS applications still return longitudes as positive 
numbers. Be sure that the longitude data in your imported layer is consistent with 
that of your address file.
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Removing Closest Site or Point-in-Polygon layers
To remove layers:

1. Select Process > Options from the menu or the   icon from the toolbar.

2. Select either the Closest Site or the Point-in-Polygon tab.

3. Select the file you want to remove from the Closest Site or Point-in-Polygon Layers 
lists and click Remove.

Adding a Closest Site or Point-in-Polygon layer
To add a layer from a geocoded database table:

1. Select Process > Options from the menu or the   icon from the toolbar.

2. Select either the Closest Site or the Point-in-Polygon tab.

The following steps apply to either chosen tab.

3. Click Add Table. A file selection dialog box appears.

4. Select the desired file and click Open. The Closest Site Table Import Settings dialog 
box appears.

5. Verify that the Latitude and Longitude fields are correct.

6. Select the field you want to use as Site Name from the drop-down list, and click OK.

Understanding the Closest Site and Point-in-Polygon 
tabs

To better understand the Closest Site and Point-in-Polygon tabs see the following table 
which describes the options available.

Option Description

Define Input Fields

Longitude Allows you to select the appropriate options for Longitude.
The options for Latitude and Longitude are the same as the Field Name under 
Assign Outputs.

Latitude Allows you to select the appropriate options for Latitude.
The options for Latitude and Longitude are the same as the Field Name under 
Assign Outputs.

Processing Parameters



 

Centrus Desktop User Guide for Windows 49

Process if Field is Blank Allows you to process only those records with missing data in a particular field, 
which you specify using the drop-down list. This is useful for cleaning up a 
previously processed database.
This option is ignored, and the record is processed if any of the following critical 
match fields are missing or empty:
•   Latitude
•   Longitude
•   Location Code
•   Match Code
This option is ignored and the record is processed if any of the following critical 
match fields begins with an "E".
•   Location Code
•   Match Code

NOTE: This option is disabled when producing a CASS report—Centrus 
Desktop must process all records for CASS compliance.

Max Distance (Miles) Informs Centrus Desktop how far to look for a site. For example, if you are 
interested only in those sites within 50 miles of an address, enter 50 in the Max 
Distance (Miles) box.

Assign Outputs

Output Assignment Associates address data elements with output field names. By default, the list 
of field names is the same as the input fields in the Define Input Fields section 
of the dialog box. You can assign address data elements to existing field 
names, or create new fields to receive the data.

NOTE: If you are using Z4 Change Processing, be sure to select the 
Z4ChangeResult address element in this dialog box.

By default, outputs are ordered alphabetically by field name. Click Output 
Assignment to view outputs ordered alphabetically by output assignment.

Available Outputs To associate a data output with an output field:
1. Select a field name.
2. Select the desired data output.
3. Click Assign.
The selected element appears in the Output Assignment column next to the 
field name to which it is assigned. An A icon appears before the output, 
signifying that the data is assigned to an output field.

To create a new field:
1. Click the data output you wish to assign.
2. Click New.
3. When the New Field window opens, specify the name, type, width, and (if 
numeric) decimal places desired, or click OK to accept the default values.
The selected output appears in the Output Assignment column next to the field 
name to which it is assigned. A P or a C icon appears before the address 
element, signifying that the data is assigned to your new output field.
If the currently selected field is an input field, click Unassign to remove its 
output assignment. If the currently selected field is a new field, click Unassign 
to delete it.
You may unassign an output assignment from any tab.

Blank if Unmatched Clears all output fields defined within the module if Centrus Desktop cannot 
match the record.

Option Description
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TObject files and layers
The Point-in-Polygon module requires geocoded addresses with Latitude/Longitude 
coordinates as input. To geocode the addresses in your files, we recommend that you use 
the Centrus Desktop Address Coding module, for the quickest, most accurate geocode 
assignments. You can even geocode and perform spatial analyses in the same task.

The available outputs are determined by the contents of the object files or layers you have 
specified in the Process Options dialog box. Geographic features (points, lines, or 
polygons) are imported into the native Centrus Desktop format. To import your data into the 
.gsb format, Centrus Desktop is able to import most popular third-party data formats.

The Point-in-Polygon tab displays only a Configure button until a .gsb file is specified in the 
Point-in-Polygon page of the Process Options dialog box.

For more information about specifying or importing layers, see Shape Layers.

Point-in-Polygon analysis
Point-in-Polygon (or PiP) analysis determines in which object, or objects, a point falls. This 
analysis requires a buffered object file, as well as a geocoded address file containing 
latitude and longitude fields. The Point-in-Polygon module can perform analyses on 
polygons, as well as buffered lines, buffered points, and buffered polygons. Centrus 
Desktop can process an entire file of points against an object file very rapidly.

The following diagram illustrates the different types of buffering.

Buffered objects allow you to determine if, for example, a point is within 500 feet of a 
shoreline, or within 2 miles of a store, or within 1.3 miles of a sales territory. Centrus 
Desktop performs buffering automatically; the only requirement is that the object file (.gsb) 
be built with buffering enabled.

A point can be located in four areas relative to a polygon. These areas are illustrated in the 
following diagram, along with the status codes which represent the areas. The status codes 
are defined in Status codes.

Buffered polygon Buffered line Buffered point
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Shape Layers
Geographic Information System (GIS) applications separate information into data layers. 
For example, store locations might be defined on one layer, with main roads on another. 
This allows for separate display and processing when necessary, but also for cross-
referencing between layers during query and analysis.

Layers are referenced to a common spatial domain so that they can be scaled and overlaid 
in such a way that any given reference point can be located on any layer and its data value 
extracted. The Primary Market Area (PMA) function generates geographic market areas 
based on store locations, customer addresses, and other values. For example:

• You can use your existing database with the PMA function to create a precise 
polygonal boundary file using the outermost address points of customers or 
prospects surrounding your store or office location.

• If you have a location-dependent business, PMAs can help you identify market 
overlap and pockets of untapped opportunity.

• To ensure that you are working with the most compact trade area possible, you can 
specify parameters that tighten the size of the boundary. For instance, you can set 
parameters to include only the closest group of customers representing 80 percent 
of your sales.
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Even if you do not have any customer data, you can use the PMA function to create trade 
areas based on simple or non-overlapping rings. You can also export geography files 
created in Centrus Desktop (GSB files) to third-party file formats.

Creating store-based PMAs
Store-based PMAs consist of one or more simple or non-overlapping rings drawn at 
distances that you specify from a store location. Both simple and non-overlapping rings may 
be inclusive (concentric circles) or exclusive (“donuts”). The resulting PMAs are saved as 
data layers in Centrus Desktop’s GSB format.

To create store-based PMAs, you must have a data file containing geocoded store locations 
with Latitude and Longitude fields and unique store identifiers. If you need to geocode the 
addresses in your files, you can use the Centrus Desktop Address Coding module. For 
more details on geocoding, see “Using Address Coding” on page 23.

To generate store-based PMAs:

1. Select Tools > Shape Layers > Generate PMA. The PMA Generation - Specify Store 
Table dialog box appears.

2. Specify the name of the geocoded Store Table you wish to use to generate PMAs. 

Note: You cannot type file names directly into the text boxes. Instead, click the Browse 
button to select the path and filenames in file selection dialog boxes. 

3. Specify the Store Input Fields. Centrus Desktop automatically fills in Latitude and 
Longitude, if possible. Check that these field names are correct.

4. Select an ID field from the drop-down list box. The ID field must contain unique values.

5. Click Next to continue. The PMA Generation - Define Output Files dialog box appears.

6. Specify the type of PMAs to generate:

• In the Type section, select Simple Rings or Non-Overlapping Rings, and 
Inclusive or Exclusive.

• In the Outputs section, specify the radius for each ring and a file name for the layer. 
You can specify up to three layers. 

7. Click Browse to select the path and file names in file selection dialog boxes.

8. Click Next to continue. The PMA Generation - Layer Options dialog box appears.

9. Specify what you want to do with the resulting PMA layers:

• Add to PIP Layer adds the PMA output files to the current list of data layers 
available to the Point-in-Polygon module.

• Show In Map starts the Map Viewer and displays the PMAs after they are created. 
You can optionally show stores, labels, and roads in the map display.

10. Click Finish.



 

Centrus Desktop User Guide for Windows 53

Creating customer-based PMAs
Customer-based PMAs are polygonal boundary files which are defined by the outermost 
address points of customers or prospects that surround one or more points—typically 
stores or office locations. The boundaries can reflect the distribution of customers, or be 
weighted to reflect some other variable, such as sales. The resulting PMAs are saved as 
data layers in Centrus Desktop’s GSB format.

To create customer-based PMAs, you must have data files containing geocoded store and 
customer locations with Latitude and Longitude fields and unique store identifiers, with 
common values in each table. If you need to geocode the addresses in your files, you can 
use the Centrus Desktop Address Coding module. For more details on geocoding, see 
“Using Address Coding” on page 23.

To generate customer-based PMAs:

1. Select Tools > Shape Layers > Generate PMA. The PMA Generation - Specify Store 
Table dialog box appears.

2. Select the Use Customer Points check box.

3. Specify the name of the geocoded Store Table you wish to use to generate PMAs.

Note: You cannot type file names directly into the file name boxes. Instead, click the 
Browse button to select the path and filenames in file selection dialog boxes. 

4. Specify the Store Input Fields. Centrus Desktop automatically fills in Latitude and 
Longitude, if possible. Check that these field names are correct.

5. Select an ID field from the drop-down list box. The ID field must contain unique values, 
and should correspond to values in the customer input table.

6. Click Next to continue. The PMA Generation - Specify Customer Table dialog box 
appears.

7. Specify the name of the geocoded Customer Table you wish to use to generate PMAs.

8. Specify the Customer Input Fields. Centrus Desktop automatically fills in Latitude and 
Longitude, if possible. Check that these field names are correct.

9. Select an ID field from the drop-down list. The ID field must contain values that 
correspond to the ID field in the store input table.

10. Select a Weight field from the drop-down list, if desired.

11. Click Next to continue. The PMA Generation - Define Output Files dialog box appears.

12. Specify the type of PMAs to generate:

• In the Type section, select Inclusive or Exclusive.
• In the Outputs section, specify the percentage of the value you would like to include 

for each PMA (for example, percentage of customers, sales, and so on).
• Specify a file name for each layer. You can specify up to three layers.

13. Click Next to continue. The PMA Generation - Layer Options dialog box appears.
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14. Specify what you wish to do with the resulting PMA layers:

• Add to PIP Layer adds the PMA output files to the current list of data layers 
available to the Point-in-Polygon module.

• Show In Map starts the Map Viewer and displays the PMAs after the PMAs are 
created. You can optionally show stores, labels, customers, and roads in the map 
display.

15. Click Finish.
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Understanding the Demographics tab
Demographics allows you to append valuable demographics to your own databases.

To use Demographics, you must either verify the populated fields, or populate them. See 
the following table for more information on the Demographics options.

Option Description

Define Input Fields

County Depending on your input data, this field auto populates and can be 
changed as needed. 

Census Tract Depending on your input data, this field auto populates and can be 
changed as needed. 

Block Group Depending on your input data, this field auto populates and can be 
changed as needed. 

Block Depending on your input data, this field auto populates and can be 
changed as needed. 

ZIP Depending on your input data, this field auto populates and can be 
changed as needed. 

ZIP + 4 Depending on your input data, this field auto populates and can be 
changed as needed. 

Processing Parameters

Process if Field is Blank Allows you to process only those records with missing data in a particular 
field, which you specify using the drop-down list. This is useful for 
cleaning up a previously processed database.
This option is ignored, and the record is processed if any of the following 
critical match fields are missing or empty:
•   Latitude
•   Longitude
•   Location Code
•   Match Code
This option is ignored and the record is processed if any of the following 
critical match fields begins with an "E".
•   Location Code
•   Match Code

NOTE: This option is disabled when producing a CASS report—
Centrus Desktop must process all records for CASS compliance.

Assign Outputs
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Output Assignment Associates address data elements with output field names. By default, 
the list of field names is the same as the input fields in the Define Input 
Fields section of the dialog box. You can assign address data elements 
to existing field names, or create new fields to receive the data.

NOTE: If you are using Z4 Change Processing, be sure to select the 
Z4ChangeResult address element in this dialog box.

By default, outputs are ordered alphabetically by field name. Click 
Output Assignment to view outputs ordered alphabetically by output 
assignment.

Available Demographics To associate a data output with an output field:
1. Select a field name.
2. Select the desired data output.
3. Click Assign.
The selected element appears in the Output Assignment column next 
to the field name to which it is assigned. An A icon appears before the 
output, signifying that the data is assigned to an output field.

To create a new field:
1. Click the data output you wish to assign.
2. Click New.
3. When the New Field window opens, specify the name, type, width, and 
(if numeric) decimal places desired, or click OK to accept the default 
values.
The selected output appears in the Output Assignment column next to 
the field name to which it is assigned. A P or a C icon appears before the 
address element, signifying that the data is assigned to your new output 
field.
If the currently selected field is an input field, click Unassign to remove 
its output assignment. If the currently selected field is a new field, click 
Unassign to delete it.
You may unassign an output assignment from any tab.
Listed below are the Available Demographics:

2010 Total Female Population

2010 Total Population

2010 Households

2010 Median Age

2010 Median Age Female

2010 Median Age Male

2010 Total Housing Units

2010 Families

2010 Average Household Size

2010 Aggregate Household ($000s)

2010 Owner Occupied Housing Units

2010 Median Household Income

Option Description
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2010 Median Family Income

2010 Median Housing Value

2010 Population in Group Quarters

2010 % White Population

2010 % Black Population

2010 % Asian/Pacific Islander Population

2010 % American Indian/Eskimo Population

2010 Total Households with Children under 18

2010 Total Households with Adults over 60

2010 Householder Age 15-24

2010 Householder Age 25-34

2010 Householder Age 35-44

2010 Householder Age 45-54

2010 Householder Age 55-64

2010 Householder Age 65-74

2010 Householder Age 75-84

2010 Householder Age 85+

Census 2010 Block Group

Census County Subdivision FIPS 55 Code

Place FIPS 55 Code

Census 2010 Block Group

NECTA

NECTA Name

Division

Division Name

Blank if Unmatched Clears all output fields defined within the module if Centrus Desktop 
cannot match the record.

Option Description
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Using Geographic Determination
Geographic determination describes both the spatial relationship between two entities and 
the degree of confidence in that description. High confidence determinations, based on any 
level of geocoding (address, ZIP + 4, ZIP + 2, or ZIP Code), are critical for many 
geographically-sensitive business decisions.

Given a geocoded address, the Geographic Determination module provides a confidence 
factor and associates it with the geocode so that additional rules may be applied. This 
confidence factor is either a distance value (between two points or lines), or a percentage 
representing the amount of overlap between two polygons.

“Changing the location of Centrus data files” on page 85 explains how to select a file for 
processing. Once you have performed these steps, you can specify the search distance 
and buffer width, assign outputs, and then click Process on the task bar to process the file 
or configure a different module.

Note: Until you specify a .gsb file on the Geographic Determination tab of the 
Process Options dialog box, the Geographic Determination tab displays only a 
Configure button.

There are two parameters that you can use to enhance your Geographic Determination 
processing.
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Note: Refer to for details on setting input and output fields.

Available outputs
The outputs available for the Geographic Determination module vary according to the type 
of file (point, line, or polygon) you specify in the Process Options dialog box. The name of 
each available output consists of the name of the GSB file, the type of file, the data element, 
and a number indicating a distance ranking from closest (1) to farthest (8).

For example, store.Line.Name.1 is the Name data element associated with the closest 
object in the .gsb file, and the data element exists in a line file called store.gsb. The number 
of distance rankings for each element is specified in the input file. The following table lists 
the Geographic Determination elements available for use with each type of file.

Option Description

Search Distance Distance, in feet, that Centrus Desktop looks for a site. The default 
search distance is 5280. For example, Centrus Desktop finds the 
distance within 5280 feet of the point and assigns a confidence level.

Buffer Width Distance, in feet, that Centrus Desktop maps the polygon. The default 
is 100 feet. For example, Centrus Desktop finds the distance within 100 
feet of the boundary and creates a polygon around it.

Field Name Explanation Available With

Name Name of the object in the file. Point, Line, Polygon

Straight Distance Straight line distance between two points. Point

Near Distance Minimum distance that exists between an error 
surface or a geocoded point and another point or 
line.

Point, Line

Far Distance Distance between the farthest point of the error 
surface and the nearest point of the feature (point, 
line or polygon).

Point, Line

Manhattan Distance Manhattan distance between two points. This is the 
distance between the points, zig-zagging along the 
streets, as opposed to the straight-line distance.

Point
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Geographic Determination tab
Use the Geographic Determination tab to determine which data layers are available to the 
Geographic Determination module. You can add data layers that are already in .gsb format, 
such as the States.gsb and Counties.gsb files. You can also import geocoded tables from 
database files, and import third-party layer files.

The Geographic Determination tab displays only a Configure button until you specify a file 
in the Geographic Determination page of the Process Options dialog box.

Adding a Geographic Determination Point file
To add a layer:

1. Click Process on the menu bar from the main Centrus Desktop screen, then select 
Options.

2. Click the Geographic Determination tab.

3. Click Add Point File. A file selection dialog box appears.

4. Select the file to add and click Open. The added file appears on the Spatial Files for 
Geographic Determination list.

Overlap Percentage of overlap between the error surface 
and the input polygon.

Polygon

ConfSurfType The error (or confidence) surface type indicates the 
type of location that the surface encloses.
0 - Nothing has been searched yet.
1 - The search failed - address was not found.
2 - Intersection level
3 - Address-level
4 - Point-level
5 - State level
6 - County level
7 - City level
8 - Not used in USA
9 - ZIP Code level
10 - ZIPCode+2 level
11 - ZIP Code+4 level
12 - Not used in USA
In general, the better the location code from 
GeoStan™, the higher quality the surface type.

Polygon

Field Name Explanation Available With
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Adding a Geographic Determination Line file
To add a layer:

1. Click Process on the menu bar from the main Centrus Desktop screen, then select 
Options.

2. Click the Geographic Determination tab.

3. Click Add Line File. A file selection dialog box appears.

4. Select the file to add and click Open. The added file appears on the Spatial Files for 
Geographic Determination list.

Note: Selecting files from the list that do not have objects for their specified type 
generates an error. Either change the object type, or browse to a different .gsb 
file.

Adding a Geographic Determination Polygon file
To add a layer:

1. Click Process on the menu bar from the main Centrus Desktop screen, then select 
Options.

2. Click the Geographic Determination tab.

3. Click Add Polygon File. A file selection dialog box appears.

4. Select the file to add and click Open. The added file appears on the Spatial Files for 
Geographic Determination list.

Note: Selecting files from the list that do not have objects for their specified type 
generates an error. Either change the object type, or browse to a different .gsb 
file.

Importing a Geographic Determination file
To import a file:

1. Click Process on the menu bar from the main Centrus Desktop screen, then select 
Options.

2. Click the Geographic Determination tab.

3. Click Import. The Import File Type dialog box appears.

Note: Geographic Determination requires that all objects in the file be of the same type.

4. Select the corresponding radio button of the file type you want to import. The Importer 
dialog box appears.

5. Select the radio button corresponding to the file type (shape files or tables files) you 
want to import.
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6. Click the appropriate Browse buttons to select the file to import, and the object file 
(.gsb) to create.

7. Click the Identifier Field drop-down list to select which field to use as identifier. 

8. Click Browse on the Output dialog box to select the object file (.gsb) to create.

9. Select the Enable Buffering checkbox to return any distance values.

10. Select the Create Spatial Attributes checkbox to create attributes with more 
information about the objects. 

For more information about Spatial attributes, see Spatial attributes.

Note: If the input file is a proprietary shape file, the file must be a .shp or .tab file. If the 
input is a table file, the type must be delimited, text, .dbf, or .mdb.

11. Click Import.

12. Click OK. The Available Outputs selection box is populated with the standard Name, 
Distance, and Direction attributes, as well as the fields contained in your import file (if 
you imported Spatial attributes). You can now assign any of these fields as output 
fields.

Note: While Western hemisphere locations are correctly expressed as negative 
longitudes, some mapping and GIS applications still return longitudes as positive 
numbers. Be sure that the longitude data in your imported layer is consistent with 
that of your address file.

Removing files
To remove files:

1. Select Process > Options from the main Centrus Desktop menu.

2. Click the Geographic Determination tab.

3. Select the file you want to remove from the Spatial Files for Geographic 
Determination list and click Remove.
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Match codes
When you use Centrus Desktop to perform address standardization, it returns a match code 
in the MatchCode output field. The match code is an alpha-numeric code that encapsulates 
information about the address standardization process—including whether or not a match 
was found, the type of match found, and why no match was found (where applicable).

Note: Not all location and match codes detailed in this appendix may be available in this 
release of Centrus Desktop.

United States
Centrus Desktop returns match codes that indicate the portions of the address that 
matched or did not match. If Centrus Desktop could not make a match, the match code 
begins with E and the remaining digits indicate why the address did not match. The digits do 
not specifically refer to which address elements did not match, but rather why the address 
did not match.

The following table contains the match code values. You can find a description of the hex 
digits for the different match codes in the table following the match code table.

Code Description

Ahhh Same as Shhh, but indicates match to an alias name record or an alternate record.

Chh Street address did not match, but located a street segment based on the input ZIP Code or city.

D00 Matched to a small town with P.O. Box or General Delivery only.

Ghhh Matched to an auxiliary file.

Hhhh House number was changed.

Jhhh Matched to a User Dictionary.

P Successful Reverse APN lookup match.

Qhhh Matched to USPS range records with unique ZIP Codes. CASS rules prohibit altering an input ZIP if it 
matches a unique ZIP Code value.

Rhhh Matched to a ranged address.

Shhh Matched to USPS data. This is considered the best address match, because it matched directly against 
the USPS list of addresses. S is returned for a small number of addresses when the matched address 
has a blank ZIP + 4.

Thhh Matched to a street segment record. Street segment records do not contain ZIP Code information. If you 
enter a ZIP Code, the application returns the ZIP Code you entered. If the input city and state has only 
one ZIP Code, the application returns that ZIP Code.

Uhhh Matched to USPS data but cannot resolve the ZIP + 4 code without the firm name or other information. 
CASS mode returns an E023 (multiple match) error code.

Xhhh Matched to an intersection of two streets, for example, “Clay St & Michigan Ave.” The first hex digit refers 
to the last line information, the second hex digit refers to the first street in the intersection, and the third 
hex digit refers to the second street in the intersection.
The USPS does not allow intersections as a valid deliverable address.
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Definitions for 1st-3rd hex digit match code values

The following table contains the description of the hex digits for the match code values.

Note: The third hex digit is only populated for intersection matches or as part of the 
Extended Match Code.

• For intersection matches, use the table below for the 3rd hex digit definition.
• For Extended Match Code, see Definitions for Extended Match Code (3rd hex digit) 

values in the next section.

Yhhh Same as Xhhh, but an alias name record was used for one or both streets.

Za No address given, but verified the provided ZIP Code.

a Zh may be returned if Correct Last Line is set to True. For more information see Correct last line match 
codes and Using correct last line.

Code In first hex position means: In second and third hex position means:

0 No change in last line. No change in address line.

1 ZIP Code changed. Street type changed.

2 City changed. Predirectional changed.

3 City and ZIP Code changed. Street type and predirectional changed.

4 State changed. Postdirectional changed.

5 State and ZIP Code changed. Street type and postdirectional changed.

6 State and City changed. Predirectional and postdirectional changed.

7 State, City, and ZIP Code 
changed.

Street type, predirectional, and postdirectional 
changed.

8 ZIP + 4 changed. Street name changed.

9 ZIP and ZIP + 4 changed. Street name and street type changed.

A City and ZIP + 4 changed. Street name and predirectional changed.

B City, ZIP, and ZIP + 4 changed. Street name, street type, and predirectional 
changed.

C State and ZIP + 4 changed. Street name and postdirectional changed.

D State, ZIP, and ZIP + 4 changed. Street name, street type, and postdirectional 
changed.

E State, City, and ZIP + 4 changed. Street name, predirectional, and postdirectional 
changed.

F State, City, ZIP, and ZIP + 4 
changed.

Street name, street type, predirectional, and 
postdirectional changed.

Code Description
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Definitions for Extended Match Code (3rd hex digit) values

The Extended Match Code returns additional information about any changes in the house 
number, unit number and unit type fields in the matched address, as well as whether there 
was address information that was ignored. This additional information is provided in a 3rd 
hex digit that is appended to match codes for address-level matches only - A, G, H, J, Q, R, 
S, T or U (see Match codes).

Note: A typical match code contains up to 4 characters: a beginning alpha character 
followed by 2 or 3 hex digits. The third hex digit is only populated for intersection 
matches or as part of the Extended Match Code.

For information about the 3rd hex digit values for:

• Intersection matches, see “Definitions for 1st-3rd hex digit match code values” on 
page 66. 

• Extended Match Codes, see the following tables.

 “Address information ignored” is specified when any of the following conditions apply:

• The output address has a mail stop (GS_MAIL_STOP).
• The output address has a second address line (GS_ADDR2).
• The input address is a dual address (two complete addresses in the input address). 

For example, “4750 Walnut St. P.O Box 50”.
• The input last line has extra information that is not a city, state or ZIP Code, and is 

ignored. For example, “Boulder, CO 80301 USA”, where “USA” is ignored when 
matching.

The following table shows examples of the Extended Match Code 3rd hex digit return 
values:

Input Addressline Output Addressline
Extended 
Code Description

4750 WALNUT ST STE 200 4750 WALNUT ST STE 200 0 Matched on all address information 
on line, including Unit Number and 
Unit Type if included.

4750 WALNUT ST C/O JOE SMITH 4750 WALNUT ST 1 Matched on Unit Number and Unit 
Type if included. Extra information 
on address line ignored. Extra 
information not considered for 
matching moved to GS_ADDR2 or 
GS_MAIL_STOP field.

4750 WALNUT ST UNIT 200 4750 WALNUT ST STE 200 2 Matched on Unit Number. Unit Type 
changed.

4750 WALNUT ST UNIT 200 C/O JOE SMITH 4750 WALNUT ST STE 200 3 Matched on Unit Number. Unit Type 
changed. Extra information on 
address line ignored. Extra 
information not considered for 
matching moved to GS_ADDR2 or 
GS_MAIL_STOP field.

4750 WALNUT ST STE 2-00 4750 WALNUT ST STE 200 4 Unit Number changed or ignored.
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The following table contains the description of the Extended Match Code 3rd hex digit 
return values:

4750 WALNUT ST STE 2-00 C/O JOE SMITH 4750 WALNUT ST STE 200 5 Unit Number changed or ignored. 
Extra information on address line 
ignored. Extra information not 
considered for matching moved to 
GS_ADDR2 or GS_MAIL_STOP 
field.

4750 WALNUT ST STE 400 4750 WALNUT ST STE 400 6 Unit Number changed or ignored. 
Unit Type changed or ignored. In 
this example, Suite 400 is not valid 
for the input address, but the 
address match is not prevented 
because of an invalid unit number.

4750 WALNUT ST UNIT 2-00 C/O JOE SMITH 4750 WALNUT ST STE 200 7 Unit Number changed or ignored. 
Unit Type changed or ignored. 
Extra information on address line 
ignored. Extra information not 
considered for matching moved to 
GS_ADDR2 or GS_MAIL_STOP 
field.

47-50 WALNUT ST STE 200 4750 WALNUT ST STE 200 8 Matched on Unit Number and Unit 
Type if included. House number 
changed or ignored.

47-50 WALNUT ST STE 200 C/O JOE SMITH 4750 WALNUT ST STE 200 9 Matched on Unit Number and Unit 
Type if included. House number 
changed or ignored. Extra 
information not considered for 
matching moved to GS_ADDR2 or 
GS_MAIL_STOP field.

47-50 WALNUT ST UNIT 200 4750 WALNUT ST STE 200 A Matched on Unit Number. Unit Type 
changed. House Number changed 
or ignored. 

47-50 WALNUT ST UNIT 200 C/O JOE SMITH 4750 WALNUT ST STE 200 B Matched on Unit Number. Unit Type 
changed. House Number changed 
or ignored. Extra information on 
address line ignored. Extra 
information not considered for 
matching moved to GS_ADDR2or 
GS_MAIL_STOP field.

47-50 WALNUT ST STE 20-0 4750 WALNUT ST STE 200 C House Number changed or ignored. 
Unit Number changed or ignored. 

47-50 WALNUT ST STE 20-0 C/O JOE SMITH 4750 WALNUT ST STE 200 D House Number changed or ignored. 
Unit Number changed or ignored. 
Extra information on address line 
ignored. Extra information not 
considered for matching moved to 
GS_ADDR2 or GS_MAIL_STOP 
field.

47-50 WALNUT ST UNIT 20-0 4750 WALNUT ST STE 200 E House Number changed or ignored. 
Unit Number changed or ignored. 
Unit Type changed or ignored.

47-50 WALNUT ST UNIT 2-00 C/O JOE SMITH 4750 WALNUT ST STE 200 F House Number changed or ignored. 
Unit Number changed or ignored. 
Unit Type changed or ignored. 
Extra information on address line 
ignored. Extra information not 
considered for matching moved to 
GS_ADDR2 or GS_MAIL_STOP 
field.

Input Addressline Output Addressline
Extended 
Code Description
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Note: For Auxiliary file matches, the 3rd hex digit is always “0”.

Code In 3rd hex position means:

0 Matched on all address information on line, including Unit Number and Unit Type if included.

1 Matched on Unit Number and Unit Type if included. Extra information on address line ignored. 
Extra information not considered for matching moved to GS_ADDR2 or GS_MAIL_STOP field.

2 Matched on Unit Number. Unit Type changed.

3 Matched on Unit Number. Unit Type changed. Extra information on address line ignored. Extra 
information not considered for matching moved to GS_ADDR2 or GS_MAIL_STOP field.

4 Unit Number changed or ignored.

5 Unit Number changed or ignored. Extra information on address line ignored. Extra information not 
considered for matching moved to GS_ADDR2 or GS_MAIL_STOP field.

6 Unit Number changed or ignored. Unit Type changed or ignored.

7 Unit Number changed or ignored. Unit Type changed or ignored. Extra information on address line 
ignored. Extra information not considered for matching moved to GS_ADDR2 or GS_MAIL_STOP 
field.

8 Matched on Unit Number and Unit Type if included. House Number changed or ignored.

9 Matched on Unit Number and Unit Type if included. House Number changed or ignored. Extra 
information not considered for matching moved to GS_ADDR2 or GS_MAIL_STOP field.

A Matched on Unit Number. Unit Type changed. House Number changed or ignored. 

B Matched on Unit Number. Unit Type changed. House Number changed or ignored. Extra 
information on address line ignored. Extra information not considered for matching moved to 
GS_ADDR2 or GS_MAIL_STOP field.

C House Number changed or ignored. Unit Number changed or ignored. 

D House Number changed or ignored. Unit Number changed or ignored. Extra information on 
address line ignored. Extra information not considered for matching moved to GS_ADDR2 or 
GS_MAIL_STOP field.

E House Number changed or ignored. Unit Number changed or ignored. Unit Type changed or 
ignored.

F House Number changed or ignored. Unit Number changed or ignored. Unit Type changed or 
ignored. Extra information on address line ignored. Extra information not considered for matching 
moved to GS_ADDR2 or GS_MAIL_STOP field.



 

Centrus Desktop User Guide for Windows 70

Definitions for “Ennn” return code values

The following table describes the values returned when the application cannot find a match 
code 

Code Description
Ennna

a Ehnn may be returned if Correct Last Line is set to True. For more information see Correct 
last line match codes and Using correct last line.

Indicates an error, or no match. This can occur when the address 
entered does not exist in the database, or the address is badly formed 
and cannot be parsed correctly. The last three digits of an error code 
indicate which parts of an address the application could not match to 
the database.

nnn = 000 No match made.

nnn = 001 Low level error.

nnn = 002 Could not find data file.

nnn = 003 Incorrect GSD file signature or version ID.

nnn = 004 GSD file out of date. Only occurs in CASS mode.

nnn = 010 No city and state or ZIP Code found.

nnn = 011 Input ZIP not in the directory.

nnn = 012 Input city not in the directory.

nnn = 013 Input city not unique in the directory.

nnn = 014 Out of licensed area. Only occurs if using Group 1 licensing 
technology.

nnn = 015 Record count is depleted and license has expired.

nnn = 020 No matching streets found in directory.

nnn = 021 No matching cross streets for an intersection match.

nnn = 022 No matching segments.

nnn = 023 Unresolved match.

nnn = 024 No matching segments. (Same as 022.)

nnn = 025 Too many possible cross streets for intersection matching.

nnn = 026 No address found when attempting a multiline match.

nnn = 027 Invalid directional attempted.

nnn = 028 Record also matched EWS data, therefore the application denied the 
match.

nnn = 029 No matching range, single street segment found

nnn = 030 No matching range, multiple street segments found
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Correct last line match codes
As mentioned in Using correct last line, when set to True, 
GS_FIND_CORRECT_LASTLINE corrects elements of the output last line, providing a 
good ZIP Code or close match on the soundex even if the address would not match or was 
non-existent.

The feature works when GS_FIND_ADDRCODE is True and the address does not match a 
candidate or when GS_FIND_Z_CODE is True and only last line information is input. The 
match codes returned are similar to Z and Ennn in that the first letter remains the same with 
the second digit changing.

Code Description

Zh No address given, but verified the provided ZIP Code .

h = 0 No change in last line.

h = 1 ZIP Code changed.

h = 2 City changed.

h = 3 City and ZIP Code changed.

h = 4 State changed.

h = 5 State and ZIP Code changed.

h = 6 State and City changed.

h = 7 State, City, and ZIP Code changed.

h = 8 ZIP + 4 changed.

h = 9 ZIP and ZIP + 4 changed.

h = A City and ZIP + 4 changed.

h = B City, ZIP, and ZIP + 4 changed.

h = C State and ZIP + 4 changed.

h = D State, ZIP, and ZIP + 4 changed.

h = E State, City, and ZIP + 4 changed.
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Ehnn Indicates an error, or no match. This can occur when the address 
entered does not exist in the database, or the address is badly 
formed and cannot be parsed correctly. The second digit of the error 
code is a hex digit which details the changes that were made to the 
last line information to correct the last line. The last two digits of an 
error code indicate which parts of an address the application could 
not match to the database. 

h = 0 No change in last line.

h = 1 ZIP Code changed.

h = 2 City changed.

h = 3 City and ZIP Code changed.

h = 4 State changed.

h = 5 State and ZIP Code changed.

h = 6 State and City changed.

h = 7 State, City, and ZIP Code changed.

h = 8 ZIP + 4 changed.

h = 9 ZIP and ZIP + 4 changed.

h = A City and ZIP + 4 changed.

h = B City, ZIP, and ZIP + 4 changed.

h = C State and ZIP + 4 changed.

h = D State, ZIP, and ZIP + 4 changed.

h = E State, City, and ZIP + 4 changed.

nn = 00 No match made.

nn = 01 Low level error.

nn = 02 Could not find data file.

nn = 03 Incorrect GSD file signature or version ID.

nn = 04 GSD file out of date. Only occurs in CASS mode.

nn = 10 No city and state or ZIP Code found.

nn = 11 Input ZIP not in the directory.

nn = 12 Input city not in the directory.

nn = 13 Input city not unique in the directory.

nn = 14 Out of licensed area. Only occurs if using Group 1 licensing 
technology.

nn = 15 Record count is depleted and license has expired.

nn = 20 No matching streets found in directory.

nn = 21 No matching cross streets for an intersection match.

Code Description
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Canada
The following tables describe the codes returned in MatchCode when a match is found. 
The first character, an alphabetic element, describes the type of match found. The two- or 
three-digit numeric (or hexadecimal) element of the code provides detailed information 
about the match. 

The following table describes the return code
.

The returned address is the best address because it was matched directly against the CPC 
list of deliverable addresses. See the following table for the interpretation of the hex digits

.

Return Code Description

Chhh Indicates a match found in CPC data; changes were made to the address 
to make it deliverable.

Vhhh Indicates a match found in CPC data; the input address is valid and no 
changes were made.

Return 
Code First Hex Position: Second And Third Hex Position:

0 No change in last line. No change in street type, direction, number, or name.

1 Postal Code was changed. Street type was changed.

2 Municipality was changed. Postfix direction was changed.

3 Municipality and Postal Code were changed. Street type and Postfix direction were changed.

4 Province was changed. House number was changed.

5 Province and Postal Code were changed. Street type and House number were changed.

6 Province and Municipality were changed. House number and Postfix direction were changed.

7 Province, Municipality, and Postal Code 
were changed.

Street type, Postfix direction, and House number were 
changed.

8 Reserved for future use. Street name was changed.

9 Reserved for future use. Street name and type were changed.

A Reserved for future use. Street name and Postfix direction were changed.

B Reserved for future use. Street name, Street type, and Postfix direction were changed.

C Reserved for future use. Street name and House number were changed.

D Reserved for future use. Street name, Street type, and House number were changed.

E Reserved for future use. Street name, House number and Postfix direction were 
changed.

F Reserved for future use. Street name, Street type, House number and Postfix direction 
were changed. 
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The following table describes the codes returned when the application cannot find a match.

Return Code Description

Ecnn Indicates an error or no match. This can occur when the address entered 
either did not exist in the GeoStan™ Canada Directory, or the address was 
badly malformed and could not be passed correctly.

nn = 01 Internal error. 

nn = 10 No Municipality+Province or Postal Code found.

nn = 20 No matching addresses.

nn = 22 Missing or wrong street name.

nn = 23 Could not resolve address.

nn = 25 Inconsistent address.

nn = 26 Missing or wrong box range.

nn = 27 Missing or wrong unit range.

nn = 40 Address vs. Postal Code conflict, SERP rule prevents correction.

nn = 41 Postal Code has multiple street names, SERP rule prevents correction.

nn = 42 Change of delivery mode attempted, SERP rule prevents correction.

nn = 43 Total number of changed address elements exceeds maximum.

nn = 44 Change of address type is not allowed for current setting.

nn = 50 Minor error.
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Location codes
Location codes indicate the accuracy of the assigned geocode. There are three types of 
geocodes, Address, ZIP+4 centroids, and Street centroids. 

• Address geocodes are simple to interpret because they indicate a geocode made 
directly to a matched street segment (or two segments in the case of an 
intersection). Address geocodes are returned when the input street address was 
matched, or when an intersection match was obtained.

• Street centroid geocodes indicate that no match was made to the input address 
number, or that no address number was included on the input. A match was made to 
a street segment within the search area. The search area is based on the input ZIP 
code. If there is no input ZIP code, the search area is based on the finance area or 
input city, depending on your address match settings. Street centroids have a range 
of confidence depending on the search area used to obtain the matching street 
segment.

• ZIP+4 centroids have a range of confidence depending upon how the ZIP+4 
centroid was determined. 

A Location Code of E indicates a location code is not available. This usually occurs when 
you have requested ZIP Code centroids of a high quality, and one is not available for that 
match. It can occur infrequently when GeoStan does not have a 5-digit centroid location. 
GeoStan can also return an E location code type when it cannot standardize an input 
address and there is no input ZIP Code. In this case, do not assume the ZIP Code returned 
with the nonstandardized address is the correct ZIP Code because GeoStan did not 
standardize the address; therefore, GeoStan does not return geocoding or Census Block 
information.

Address location codes
Address location codes detail the known qualities about the geocode. An address location 
code has the following characters.

1st character Always an A indicating an address location.

2nd character May be one of the following 

C Interpolated address point location.

G Auxiliary file data location.

I Application infers the correct segment from the 
candidate records.

P Point-level data location.

R Location represents a ranged address.

S Location on a street range.

X Location on an intersection of two streets.

3rd and 4th characters Digit indicating other qualities about the location. 
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The following table contains the address codes.

Code Description

AGn Indicates an auxiliary file for a geocode match where n is one of the 
following values:

n=0 The geocode represents the center of a parcel or building.

n=1 The geocode is an interpolated address along a segment.

n=2 The geocode is an interpolated address along a segment, and the side 
of the street cannot be determined from the data provided in the 
auxiliary file record.

n=3 The geocode is the midpoint of the street segment.

APnn Indicates a point-level geocode match representing the center of a 
parcel or building, where nn is one of the following values:

nn=00 User Dictionary centroid. Geocode returned by a User Dictionary.

nn=02 Parcel centroid
Indicates the center of an assessor’s parcel (tract or lot) polygon. When 
the center of an irregularly shaped parcel falls outside of its polygon, the 
centroid is manually repositioned to fall inside the polygon as closely as 
possible to the actual center.

nn=04 Address point
Represents field-collected GPS points with field-collected address 
data.

nn=05 Structure point
Indicates a location within a building footprint polygon that is associated 
with the matched address.
Usually, residential addresses consist of a single building. For houses 
with outbuildings (detached garages, sheds, barns, etc.), the structure 
point will typically fall on the primary structure.
Condominiums and duplexes have multiple, individual addresses and 
may have multiple structure points for each building.  Multi-unit 
buildings are typically represented by a single structure point 
associated with the primary/base address, rather than discrete 
structure points for each unit.
Shopping malls, industrial complexes, and academic or medical center 
campuses are commonly represented by a single structure point 
associated with the primary/base address for the entire complex. When 
multiple addresses are assigned to multiple buildings within one 
complex, multiple structure points may be represented within the same 
complex.

nn=07 Manually placed
Address points are manually placed to coincide with the midpoint of an 
assessor’s parcel’s street frontage at a distance from the center line.

nn=08 Front door point
Represents the designated primary entrance to a building. If a building 
has multiple entrances and there is no designated primary entrance or 
the primary entrance cannot readily be determined, the primary 
entrance is chosen based on proximity to the main access street and 
availability of parking.

nn=09 Driveway offset point
Represents a point located on the primary access road (most 
commonly a driveway) at a perpendicular distance of between 33-98 
feet (10-30 meters) from the main roadway.



 

Centrus Desktop User Guide for Windows 77

nn=10 Street access point
Represents the primary point of access from the street network. This 
address point type is located where the driveway or other access road 
intersects the main roadway.

nn=21 Base parcel point
The Centrus point data includes individual parcels that may be 
"stacked".These stacked parcels are individually identified by their unit 
or suite number, and GeoStan is able to match to this unit number and 
return the correct APN.If an input address is for a building or complex, 
without a unit number.The "base" parcel information returns and will not 
standardize to a unit number or return additional information such as an 
APN. 

nn=22 Backfill address point
The precise parcel centroid is unknown. The address location assigned 
is based on two known parcel centroids.

nn=23 Virtual address point
The precise parcel centroid is unknown. The address location assigned 
is relative to a known parcel centroid and a street segment end point.

nn=24 Interpolated address point
The precise parcel centroid is unknown. The address location assigned 
is based on street segment end points.

AIn The correct segment is inferred from the candidate records at match 
time.

ASn House range address geocode. This is the most accurate street     
interpolated geocode available. 

AIn, ASn, and ACnh share the same values for the 3rd character “n” as follows:

n=0 Best location.

n=1 Street side is unknown. The Census FIPS Block ID is assigned from the 
left side; however, there is no assigned offset and the point is placed 
directly on the street.

n=2 Indicates one or both of the following:
• The address is interpolated onto a TIGER segment that did not 

initially contain address ranges.
• The original segment name changed to match the USPS spelling. 

This specifically refers to street type, predirectional, and 
postdirectional.

NOTE: Only the second case is valid for non-TIGER data because 
segment range interpolation is only completed for TIGER data.

n=3 Both 1 and 2.

n=7 Placeholder. Used when starting and ending points of segments 
contain the same value and shape data is not available.

ACnh Indicates a point-level geocode that is interpolated between 2 parcel 
centroids (points), a parcel centroid and a street segment endpoint, or 
2 street segment endpoints. 

The ACnh 4th character “h” values are as follows:

h=0 Represents the interpolation between 2 points, both coming from User 
Dictionaries. 

Code Description
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h=1 Represents the interpolation between 2 points. The low boundary came 
from a User Dictionary and the high boundary, from a non-User 
Dictionary.

h=2 Represents the interpolation between 1 point and 1 street segment end 
point, both coming from User Dictionaries.

h=3 Represents the interpolation between 1 point (low boundary) and 1 
street segment end point (high boundary). The low boundary came 
from a User Dictionary and the high boundary from a non-User 
Dictionary. 

h=4 Represents the interpolation between 2 points. The low boundary came 
from a non-User Dictionary and the high boundary from a User 
Dictionary. 

h=5 Represents the interpolation between 2 points, both coming from non-
User Dictionaries. 

h=6 Represents the interpolation between 1 point (low boundary) and 1 
street segment end point (high boundary). The low boundary came 
from a non-User Dictionary and the high boundary from a User 
Dictionary.

h=7 Represents the interpolation between 1 point and 1 street segment end 
point and both came from non-User Dictionaries. 

h=8 Represents the interpolation between 1 street segment end point and 
1 point, both coming from User Dictionaries.

h=9 Represents the interpolation between 1 street segment end point (low 
boundary) and 1 point (high boundary). The low boundary came from a 
User Dictionary and the high boundary from a non-User Dictionary.

h=A Represents the interpolation between 2 street segment end points, 
both coming from User Dictionaries. 

h=B Represents the interpolation between 2 street segment end points. The 
low boundary came from a User Dictionary and the high boundary from 
a non-User Dictionary.

h=C Represents the interpolation between 1 street segment end point (low 
boundary) and 1 point (high boundary). The low boundary came from a 
non-User Dictionary and the high boundary from a User Dictionary.

h=D Represents the interpolation between 1 street segment end point and 
1 point, both coming from non-User Dictionary.

h=E Represents the interpolation between 2 street segment end points. The 
low boundary came from a non-User Dictionary and the high boundary 
from a User Dictionary.

h=F Represents the interpolation between 2 street segment end points, 
both coming from non-User Dictionaries.

ARn Ranged address geocode, where “n” is one of the following:

n=1 The geocode is placed along a single street segment, midway between 
the interpolated location of the first and second input house numbers in 
the range.

n=2 The geocode is placed along a single street segment, midway between 
the interpolated location of the first and second input house numbers in 
the range, and the side of the street is unknown. The Census FIPS 
Block ID is assigned from the left side; however, there is no assigned 
offset and the point is placed directly on the street.

Code Description
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Street centroid location codes
Street centroid location codes indicate the Census ID accuracy and the position of the 
geocode on the returned street segment. A street centroid location code has the following 
characters.

The following table contains the values and descriptions for the location codes.

n=4 The input range spans multiple USPS segments.  The geocode is 
placed on the endpoint of the segment which corresponds to the first 
input house number, closest to the end nearest the second input house 
number. 

n=7 Placeholder. Used when the starting and ending points of the matched 
segment contain the same value and shape data is not available.

AXn Intersection geocode, where “n” is one of the following:

n=3 Standard single-point intersection computed from the center lines of 
street segments.

n=8 Interpolated (divided-road) intersection geocode. Attempts to return a 
centroid for the intersection.

Code Description

1st character Always “C” indicating a location derived from a street segment. 

2nd character Census ID accuracy based on the search area used to obtain matching 
Street Segment. 

3rd character Location of geocode on the returned street segment.

Character 
position Code Description

2nd Character

B Block Group accuracy (most accurate). Based on input ZIP 
Code.

T Census Tract accuracy. Based on input ZIP Code.

C Unclassified Census accuracy. Normally accurate to at least the 
County level. Based on input ZIP Code.

F Unknown Census accuracy. Based on Finance area. 

P Unknown Census accuracy. Based on input City.

3rd Character

C Segment Centroid.

L Segment low-range end point.

H Segment high-range end point.
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ZIP + 4 centroid location codes
ZIP + 4® centroid location codes indicate the quality of two location attributes: Census ID 
accuracy and positional accuracy. A ZIP + 4 centroid location code has the following 
characters.

The following table contains the values and descriptions for the location codes.

1st character Always “Z” indicating a location derived from a ZIP centroid. 

2nd character Census ID accuracy. 

3rd character Location type.

4th character How the location and Census ID was defined. Provided for completeness, 
but may not be useful for most applications.

Character 
position Code Description

2nd Character

B Block Group accuracy (most accurate).

T Census Tract accuracy.

C Unclassified Census accuracy. Normally accurate to at least the 
County level.

3rd Character

5 Location of the Post Office that delivers mail to the address, a 5-
digit ZIP Code centroid, or a location based upon locale (city). 
See the 4th character for a precise indication of locational 
accuracy.

7 Location based upon a ZIP + 2 centroid. These locations can 
represent a multiple block area in urban locations, or a slightly 
larger area in rural settings.

9 Location based upon a ZIP + 4 centroid. These are the most 
accurate centroids and normally place the location on the 
correct block face. For a small number of records, the location 
may be the middle of the entire street on which the ZIP + 4 falls. 
See the 4th character for a precise indication of locational 
accuracy.

4th Character

A Address matched to a single segment. Location assigned in the 
middle of the matched street segment, offset to the proper side 
of the street.

a Address matched to a single segment, but the correct side of the 
street is unknown. Location assigned in the middle of the 
matched street segment, offset to the left side of the street, as 
address ranges increase.

B Address matched to multiple segments, all segments have the 
same Block Group. Location assigned to the middle of the 
matched street segment with the most house number ranges 
within this ZIP + 4. Location offset to the proper side of the 
street.
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b Same as methodology B except the correct side of the street is 
unknown. Location assigned in the middle of the matched street 
segment, offset to the left side of the street, as address ranges 
increase.

C Address matched to multiple segments, with all segments 
having the same Census Tract. Returns the Block Group 
representing the most households in this ZIP + 4. Location 
assigned to t he middle of the matched street segment with the 
most house number ranges within this ZIP + 4. Location offset 
to the proper side of the street.

c Same as methodology C except the correct side of the street is 
unknown. Location assigned in the middle of the matched street 
segment, offset to the left side of the street, as address ranges 
increase.

D Address matched to multiple segments, with all segments 
having the same County. Returns the Block Group representing 
the most households in this ZIP + 4. Location assigned to the 
middle of the matched street segment with the most house 
number ranges within this ZIP + 4. Location offset to the proper 
side of the street.

d Same as methodology D except the correct side of the street is 
unknown. Location assigned in the middle of the matched street 
segment, offset to the left side of the street, as address ranges 
increase.

E Street name matched; no house ranges available. All matched 
segments have the same Block Group. Location placed on the 
segment closest to the center of the matched segments. In most 
cases, this is on the mid-point of the entire street.

F Street name matched; no house ranges available. All matched 
segments have the same Census Tract. Location placed on the 
segment closest to the center of the matched segments. In most 
cases, this is on the mid-point of the entire street.

G Street name matched (no house ranges available). All matched 
segments have the same County. Location placed on the 
segment closest to the center of the matched segments. In most 
cases, this is on the mid-point of the entire street.

H Same as methodology G, but some segments are not in the 
same County. Used for less than .05% of the centroids.

I Created ZIP + 2 cluster centroid as defined by methodologies A, 
a, B, and b. All centroids in this ZIP + 2 cluster have the same 
Block Group. Location assigned to the ZIP + 2 centroid.

J Created ZIP + 2 cluster centroid as defined by methodologies A, 
a, B, b, C, and c. All centroids in this ZIP + 2 cluster have the 
same Census Tract. Location assigned to the ZIP + 2 centroid.

K Created ZIP + 2 cluster centroid as defined by methodologies A, 
a, B, b, C, c, D, and d. Location assigned to the ZIP + 2 centroid.

L Created ZIP + 2 cluster centroid as defined by methodology E. 
All centroids in this ZIP + 2 cluster have the same Block Group. 
Location assigned to the ZIP + 2 centroid.

M Created ZIP+2 cluster centroid as defined by methodology E 
and F. All centroids in this ZIP + 2 cluster have the same Census 
Tract. Location assigned to the ZIP + 2 centroid.

Character 
position Code Description
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Geographic centroid location codes
Geographic centroid location codes indicate the quality of two location attributes: the 
geographic location and area type 

The following table contains the values and descriptions for the location codes.

Note: The offset distance is 50 feet (default), or the value specified in the Address Coding 
tab of the Process Options dialog box (for more information about setting the offset 
distance, see Offset/Backset.

N Created ZIP + 2 cluster centroid as defined by methodology E, 
F, G, and H. Location assigned to the ZIP + 2 centroid.

O ZIP Code is obsolete and currently not used by the USPS. 
Historic location assigned.

V Over 95% of addresses in this ZIP Code are in a single Census 
Tract. Location assigned to the ZIP Code centroid.

W Over 80% of addresses in this ZIP Code are in a single Census 
Tract. Reasonable Census Tract accuracy. Location assigned to 
the ZIP Code centroid.

X Less than 80% of addresses in this ZIP Code are in a single 
Census Tract. Census ID is uncertain. Location assigned to the 
ZIP Code centroid.

Y Rural or sparsely populated area. Census code is uncertain. 
Location based upon the USGS places file.

Z P.O. Box or General Delivery addresses. Census code is 
uncertain. Location based upon the Post Office location that 
delivers the mail to that address

Character 
position Code Description

1st character Always “G” indicating a location derived from a geographic centroid. 

2nd character Geographic area type. 

Character 
position Code Description

2nd Character

M Municipality (city).

C County.

S State.
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ZIP Centroid Matches

In the Options dialog box, there are several choices for Minimum Quality when selecting 
ZIP Centroid Matching. The following indicates which methodologies (the fourth character 
in the location code) are used for each Quality selection.

Note: This option does not affect Canadian processing.

GeoStan Canada location codes
If Centrus Desktop finds a valid Postal Code centroid, it returns one of the following location 
codes: 

Minimum Quality Selection Methodology

9-Digit Best Location A, a, B, b, C, c, D, d

9-Digit Good Location A, a, B, b, C, c, D, d, E, F, G, H

9- or 7-Digit Location A, a, B, b, C, c, D, d, E, F, G, H, I, J, K, L, M, N

Block Group Accuracy A, a, B, b, E, I, L

Census Tract Accuracy A, a, B, b, E, I, L, C, c, F, J, M, V

5-Digit Only V, W, X, Y, Z

All Centroids Can return all Methodology codes.

GeoStan Location Code Description

CAN6 Postal Code level geocode

EC Geocode unavailable
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Changing the location of Centrus data files
This section will help you set up Centrus Desktop so you can use it more effectively.

Centrus Desktop requires specific data files for different types of processing. You must 
define the path to these files must be defined in the Configuration dialog box, which you can 
access from the File menu. 

Note: To change the search path, enter the new (semicolon-separated) path into the text 
field.

If you wish to specify a location for some of the data files, click Advanced. Data files include 
ZIP Code centroid, ZIP Code boundary, Delivery Point Validation (DPV), LACSLink, 
SuiteLink, and Residential Delivery Indicator (RDI) data paths. 

To access all Centrus Desktop data files from the Centrus Desktop program directory, you 
may use the default search paths as configured during installation. The search path can 
contain up to 256 characters.

The following table lists the Centrus Desktop data files by module:

Module Data Files Notes

Address Coding • ctyst.dir
• cbsac.dir (optional)
• parse.dir
• us.z9
• us.gsd
• point-level data sets 

(optional)

To change the search path to the us.z9 or the Custom.isd 
files, click Advanced.

Demographic Coding • census2k.dld Contains information from the US Census.

Geographic 
Determination

• zip5.gsb To change the search path to the Zip5.gsb, click Advanced.
This file is only available if you are licensed for GDL and if you 
specified that it be installed during the data installation 
process.
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The following table lists other Centrus Desktop files.

Function Data Files Notes

CASS Compliance • us.gsz
• use.gsd
• usw.gsd
• zip9e.gsu
•  zip9w.gsu
• ctyst.dir
• parse.dir

Required for CASS compliance and to generate 
a CASS report. They are not, however, required 
for processing in CASS mode.

Extended Alias 
Information 
Processing

• us_p.gsi (use with us.gsd)
• us_ps.gsi (use with us.gsd & ust.gsd)
• usca.gsi (Centrus Alias Data Set - 

use with us.gsd & ust.gsd)

Canadian Address 
Processing

• ncoderef.dat
• gscgcodes.cp9

These files are installed in the executable 
directory.

Intersection 
Matching

• ust.gsd
• us.gsi (state-wide intersection)

Used for manual geocoding and mapping.
The optional files allow intersection matching 
without a complete last line.

NAD Conversion • alaska.las
• alaska.los
• conus.las
• conus.los
• prvi.las
• prvi.los

For more information on NAD conversion, see 
“Return coordinates in...” on page 40.

User Dictionary • postinfo.jdr
• postinfo.jdx
• lastline.jdr
• post2sac.mmj
• geo2sac.mmj
• sac2fn_ud.mmj
• ud1.jdr
• ud1.jdx
• ud1.bdx
If your data includes place names, the 
dictionary contains the following files:
• ud1.pdx
• ud1.pbx
The dictionary also contains these log 
files:
• ud1.log
• ud1.err

For more information see Understanding 
User Dictionaries.
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Understanding User Dictionaries
A User Dictionary is a table of streets and address ranges that you use as a source for 
geocoding. If you have newer or more precise data than what is available in GSD files, 
creating a dictionary with this data can help you obtain more accurate geocoding results. 
For example, if you have address point data you can create a User Dictionary that enables 
you to take advantage of the GeoStan™ address point interpolation capabilities.

A User Dictionary can be used by itself to geocode records, or can be used in combination 
with the supplied GSD.

You can also specify the search priority for matching against GSD records and User 
Dictionary records. This option allows greater control over which candidates are returned; in 
particular, it enables selection of User Dictionary candidates over GSD candidates.

For more information see User Dictionary.

Note: The USPS does not consider matches to data that they did not create and these are 
not considered valid addresses for postal delivery. Therefore, Desktop does not 
match to User Dictionaries when processing in CASS mode.

Processing a task from the command line
You can also run Centrus Desktop from the command line. Several command-line options 
are available. The syntax is: 

Centrus FileName.qmi /q /b /d /n /e /h

The following table outlines each of these options.

Command Line Option Description
FileName.qmi Specifies a saved task to load immediately.

/q Starts Centrus Desktop in QuickFind, suppressing the splash 
screen.

/b Starts Centrus Desktop in batch mode, bypassing the splash 
screen. Use this switch with a FileName.qmi argument to open 
the task file and immediately begin batch processing.

/n Starts Centrus Desktop with no splash screen.

/e Causes the application to exit upon completion of processing. 
Typically used in conjunction with the /b option and qmi 
function. 
If you open Centrus Desktop with the /e option only, and then 
define a new task to process, Centrus Desktop closes once the 
task completes.

/h Displays descriptions for each of the command-line options.
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Using USPS Link Products
This section highlights Delivery Point Validation (DPV), Locatable Address Conversion 
System process (LACSLink), and Residential Delivery Indicator (RDI) available with this 
Centrus product.

DPV overview
Delivery Point Validation (DPV™) is a United States Postal Service (USPS®) technology that 
validates the accuracy of address information down to the physical delivery point. DPV is 
only available through a CASS-certified vendor, such as Precisely.

Previous address-matching software could only validate that an address fell within the low-
to-high address range for the named street. By incorporating the DPV technology, you can 
resolve multiple matches and determine if the actual address exists. Using DPV reduces 
undeliverable-as-addressed (UAA) mail that results from inaccurate addresses, reducing 
postage costs and other business costs associated with inaccurate address information.

DPV also provides unique address attributes to help produce more targeted mailing lists. 
For example, DPV can indicate if a location is vacant and can identify commercial mail 
receiving agencies (CMRAs) and private mail boxes.

Although DPV can validate the accuracy of an existing address, you cannot use DPV to 
create address lists. DPV is a secure dataset of USPS addresses. For example, you can 
validate that 123 Elm Street Apartment 6 exists, but you cannot ask who lives in Apartment 
6 or if there is an Apartment 7 at the same street address.

With DPV, your application automatically processes every ZIP+4 coded record against the 
DPV files. Using DPV may increase your ZIP+4 match rate, but may also increase 
processing time. Therefore, you may not wish to use DPV if you are not CASS certifying.
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LACSLink overview
The Locatable Address Conversion System (LACS) converts rural addresses to city-style 
addressees. LACSLink is a USPS technology that provides mailers with an automated 
process to correct address lists for areas that have undergone LACS processing. Address 
list conversions occur when the LACS process modifies, changes, or replaces an address. 
This usually occurs due to one of the following: the conversion of rural routes and box 
numbers to city-style addresses, the renaming or renumbering of existing city-style 
addresses to avoid duplication, or the establishment of new delivery addresses. 

LACSLink is a secure dataset of USPS addresses. Although LACSLink can validate the 
accuracy of an existing address, you cannot use LACSLink to create address lists.

Note: LACSLink is not run in multiple match searches.

False positive addresses overview 
False positive addresses, also known as seed records, are addressees the USPS monitors 
to ensure users are not attempting to create a mailing list from the DPV or LACSLink data. 

Note: Per the USPS regulations, Precisely must contact the USPS with the name and 
address of the organization for every false positive address encountered. If multiple 
incidents of artificial address detection occurs, the USPS may ask Precisely to 
suspend a customer’s DPV or LACSLink processing capability.

If you encounter a false positive, you will receive a message. Processing continues to the 
end of your job, but further DPV or LACSLink processing is disabled. DPV or LACSLink 
processing is not available for subsequent jobs until you have reported the false-positive 
address encounter to Precisely and have received a new security key.

A message similar to the following appears when you encounter a false positive address:

DPV DPV processing was terminated due to the detection of what is determined to be 
an artificially created address. No address beyond this point has been DPV 
validated. In Accordance with the License Agreement between USPS and 
Precisely, DPV shall be used to validate legitimately obtained addresses only, 
and shall not be used for the purpose of artificially creating address lists. The 
written Agreement between Precisely and the Precisely customer shall also 
include the same restriction against using DPV to artificially create address lists. 
Continuing use of DPV requires compliance with all terms of the License 
Agreement. If you believe this address was identified in error, please contact 
Precisely.

LACS/Link LACS/Link processing was terminated due to the LACS/Link DEVELOPER 
LICENSEE PERFORMANCE REQUIREMENTS detection of what is determined 
to be an artificially created address. No address beyond this point has been 
LACS/Link processed. In accordance with the License Agreement between 
USPS and Precisely, LACS/Link shall be used to convert legitimately obtained 
addresses only, and shall not be used for the purpose of artificially creating 
address lists. The written Agreement between Precisely and the Precisely 
customer shall also include this same restriction against using LACS/Link to 
artificially create address lists. Continuing use of LACS/Link requires compliance 
with all terms of the License Agreement. If you believe this address was identified 
in error, please contact Precisely.
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When implementing DPV and LACSLink you need to create a false positive file that contains 
the Header Record and Detail Record information. You must provide this file to obtain a new 
security file from Precisely Technical Support. 

For information purposes, the following tables contain the layout of the header and detail 
records of the false positive files for DPV and LACSLink. The header record contains the 
mailer information from the Mailer Parameter Record and statistics gathered by the 
application. 

Note: Positions 156-180 in the previous table do not exist in the LACSLink false-positive 
header record.

The detail record contains false positive record information.

Position Length Description Format

1-40 40 Company name alphanumeric

41-98 58 Address line alphanumeric

99-126 28 City name alphanumeric

127-128 2 State abbreviation alphabetical

129-137 9 9-digit ZIP code numeric

138-146 9 Total records DPV/LACSLink  processed numeric

147-155 9 Total records DPV/LACSLink  matched numeric

156-164 9 % match rate to DPV numeric

165-173 9 % match rate to ZIP+4 numeric

174-178 5 Number of ZIP codes on file numeric

179-180 2 Number of false-positives numeric

Position Length Description Format

1-2 2 Street pre-directional alphanumeric

3-30 28 Street name alphanumeric

31-34 4 Street suffix abbreviation alphanumeric

35-36 2 Street post-directional alphanumeric

37-46 10 Address primary number alphanumeric

47-50 4 Address secondary abbreviation alphanumeric

51-58 8 Address secondary number numeric

59-63 5 Matched ZIP code numeric
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Data expiration
The USPS has determined that the ZIP+4 Directory data, DPV data, and LACSLink data 
expire in 105 days for CASS processing. The date is measured from the release of the 
Postal database, which is the 15th of the month indicated on the Precisely data CD. For 
example, the June data release is good for 105 days from the 15th of June. However, in 
non-CASS processing modes, ZIP+4 data expires in 135 days.

RDI overview
The Residential Delivery Indicator (RDI™) is a United States Postal Service (USPS®) data 
product that identifies whether a delivery type is classified as residential or business. If you 
are shipping to residences, you may lower costs by shipping with the Postal Service™ and 
avoid residential delivery surcharges typically charged by other shipping companies. 

Note: To use RDI, DPV must also be initialized. 

64-67 4 Matched ZIP+4 numeric

68-180 113 Filler

Position Length Description Format



C – Data file reference
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Input table
By default, the file selection dialog box for input files shows files with the .mdb extension. 
To view other file types, select the appropriate option from the Files of Type list box in the 
file selection dialog box.

The Files of Type list box contains the type All Text Files (*.*). Select this type to show all 
files of all types. However, any file you select opens as an ASCII text file. Do not use this 
option to open binary files.

Once you select your input file, Centrus Desktop determines the assignment of the fields in 
that file. The following table describes how Centrus Desktop handles typical input file fields.

Output table
Use the Output Tables area to tell Centrus Desktop where you want to direct the output. 
Centrus Desktop can either write updated data back to the input file (not recommended), or 
create a new output file.

To create an output file, enter the name of the output file to create. If the Output Tables 
section is dimmed, be sure the In-Place Update option is not checked—Precisely 
recommends that you do not use this option.

Note: If a file already exists with the same name as the specified output file, Centrus 
Desktop overwrites that file.

When you use an output file, you can set which records Centrus Desktop writes to the 
output file using the radio buttons listed below the output file name.

Input Table Field Assignment

• Boolean
• Date
• Date Time
• Floating Point
• Integer
• Long Integer
• Short Integer
• String
• Unsigned Long
• Unsigned Integer
• Unsigned Short

Placed in the output table.

• Currency
• Decimal
• Numeric (unlimited precision)
• Time

Generates a warning that they will be converted to string.

All other fields Generates a warning that the data is not placed in the output 
table (no string conversion available).
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The output file has the same field names as the input file, along with any fields added during 
processing.

If an existing output table is being modified with unsupported data types (Update in Place is 
specified), processing halts.

The following options control how Centrus Desktop writes records:

• All – This selection writes every record from the input file to the output file, even records 
that are not processed, standardized, or geocoded.

• Reject Records That Are Not – This selection lets you specify the conditions that a 
record must meet before being written to an output file.

You can specify a reject file to contain all the records that did not meet specified conditions. 
To use a reject file, make sure to select the Reject Records That Are Not check box, and 
specify any or all of the following conditions:

• Matched
• Standardized (requires you to set ZIP4, ZIP9, or ZIP10 as an output field)
• Geocoded
• Demographic Coded
• Point-in-Polygon Coded
• Closest Site Coded

Then, click Browse and specify the path and file name of the reject file in the file selection 
dialog box. The reject file has the same fields as the input and output files, along with any 
fields added during processing.

Centrus Desktop uses the input or output file type as the default. Centrus Desktop chooses 
the output file type when you have specified both input and output file types.

Report Files
The Report Files area of the Tables tab allows you to create two different reports: an Audit 
Report and a Log Report.

To specify an audit report, be sure to select the check box next to the Audit text box, then 
click Browse and specify the path and file name in the file selection dialog box.

To specify a log report, click Browse next to the Log text box, and specify the path and file 
name in the file selection dialog box.

Audit report example
The Audit report provides a snapshot of the processing performed by Centrus Desktop. The 
report lists each record as it was input, and as it was processed by Centrus Desktop, along 
with the Match and Location codes. This presents a quick view of what Centrus Desktop 
accomplished on a certain set of records.
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You select the frequency of the snapshot. For example, if you have a 50,000 record file, and 
choose a sample frequency of 1,000, you get 50 records in your Audit report. 

Note: If you select a frequency of 1, every record in the input file is sent to the Audit file. 
This results in a large file, and is not recommended.

The following is a sample Audit report:

Log report example
The Log report provides extensive detail regarding the file and options used to geocode, as 
well as the processing results. You can display this report in Windows Notepad by checking 
the View log file when processing is completed check box.

**************************************************************
 Record Number: 1000
  Input Address
    443 ROBIN  
    WAVERLY OH 
  Output Results
    443 Robin Rd 
    Waverly, OH  45690-1557 
    Match Code: S91  ZIP and ZIP+4 were changed.
                     Street type was changed.
    Location Code: AS0  Exact Address Match.
 *************************************************************
 Record Number: 2000
  Input Address
    360 TOWN AND COUNTRY VLG 
    PALO ALTO CA 94301 
  Output Results
    855 El Camino Real Ste 360 
    Palo Alto, CA  94301-2326 
    Match Code: A89  ZIP+4 was changed.
                     Street name and Street type were changed.
    Location Code: AS0  Exact Address Match.
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The following is an extract from a Log report:

  Unmatched..............................     21 (0.34%)
    E001: Low level error................      0
    E002: State file not found...........      0
    E003: Invalid file...................      0
    E004: File is out of date............      0
    E010: Unrecognized last line.........      0
    E011: ZIP not found..................     10
    E012: City not found.................      0
    E013: City not unique................      5
    E014: Out of licensed area...........      0
    E020: No matching streets............      0
    E021: No cross streets...............      5
    E022: No matching ranges.............      0
    E023: Match is unresolved............      1
    E025: Too many cross streets.........      0
  Standardized Address Quality:
    Original Address Unchanged...........  92.23%
    Original Last Line Unchanged.........  70.95%
    Corrected prefix direction...........      4
    Corrected street name................      2
    Corrected street suffix..............     16
    Corrected postfix direction..........      1
    Corrected city name..................      5
    Corrected state abbreviation.........      0
    Corrected ZIP Code...................      8
    Corrected ZIP+4 add on...............     73
  Geocodes Assigned......................     78 (1.27%)
    Address..............................     59 (0.96%)
    ZIP Centroids........................     19 (0.31%)
       Location Accuracy: 
          ZIP+4..........................      5
          ZIP+2..........................      1
          ZIP Code.......................     13
       Census Accuracy: 
          Block Group....................      6
          Census Tract...................      2
          County.........................     11
Note: All percentages are based on records processed.
CANADIAN ADDRESS STATISTICS:
  Addresses Matched......................   4378 (71.15%)
    Standardized.........................   4378
  Unmatched..............................   1680 (27.30%)
    EC01: Internal error.................      0
    EC10: No Lastline info found.........      0
    EC20: No matching addresses..........      1
    EC22: Missing or wrong street range..      0
    EC23: Could not resolve address......    501
    EC25: Inconsistent address...........     64
    EC26: Missing or wrong box range.....    508
    EC27: Missing or wrong unit range....    286
    EC40: Address/Postal Code conflict...      6
    EC41: Multiple street ranges.........    193
    EC42: Change of delivery mode........      0
    EC43: Exceeded address changes.......      0
    EC44: Address type change not allowed      3
    EC50: Minor error....................      0
  Standardized Address Quality:
    Original Address Unchanged...........    379 (6.16%)
    Corrected Postal Code................    454
    Corrected Municipality...............   3478
    Corrected Province...................   3391
    Corrected street type................    476
    Corrected street postfix.............    444
    Corrected house number,,,,,..........      0
    Corrected street name................    829
    Corrected for unit, PO Box, General Delivery or Route
      Corrected Keyword..................    954
      Corrected Number...................   1161
    Corrected Station Type...............     24
    Corrected Station Name...............      0
  Geocodes Assigned......................   4062 (66.02%)
Note: All percentages are based on records processed.
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Preparing data files
This section provides detailed information on defining input and output text files for use with 
Centrus Desktop.

Defining input text file properties
You must define the properties of a text file that you wish to use as input to Centrus 
Desktop. When you select a *.txt file from the Select File to Process dialog box, Centrus 
Desktop launches a series of dialog boxes that provide the options for defining your file.

To define the properties of your input text file:

1. Select a text file for input from the Select File to process dialog box. The Step 1 of 3 
dialog box appears.

2. Choose a file type:

• Delimited — you must select a delimiter character on the Step 2 of 3 dialog box.
• Fixed width — Centrus Desktop examines the file for the longest field width and 

uses that value.

3. Choose a method for dealing with the first line:

• First line has field names — indicates that the first line contains header 
information for the fields.

• Ignore first line — Centrus Desktop ignores the first line in processing.

4. Set the record length using the up and down arrows.

5. Click Next.

If you selected Fixed Width on the first dialog box, the Step 2 of 3 dialog box for the 
fixed-width option appears. Follow the directions on the dialog box to create, move, or 
delete a line break.

If you selected Delimited on the first dialog box, the Step 2 of 3 dialog box for the 
delimited option appears. Select a Delimiter Type from the following options: Comma, 
Semicolon, Tab, Slash, or you may enter the character of your choice in the Other field.

6. Click Next. The Step 3 of 3 dialog box appears.

Note: If you selected Fixed width on the Step 1 of 3 dialog box, the Width field is 
grayed out.

7. Enter a name for this field in the Name field.

8. Choose a type from the Type: list box. There is no additional definition needed for the 
Character option.

• If you select Number, then you must select the number of decimal places you want 
to use to represent that number. Use the up and down arrows in the Decimals field.

• If you select Date. then you must enter the date format in the Date Picture field.
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9. Click Finish when you are done.

Defining output text file properties
Centrus Desktop allows you to control the format of output text files.

To define text file properties:

1. Select Text Files from the Select Output File dialog box.

After you select the text file, the Text File Properties dialog box appears.

2. Select the Fixed Width option for fixed-width file types. This option disables the 
Delimiter Type and Qualifier controls on the dialog box.

—or—

Select the Delimited option for delimited file types. This option activates the Delimiter 
Type and Qualifier controls on the dialog box.

After you click either the Fixed Width or Delimited radio button, the OK button 
becomes active.

3. Select a delimiter type from the options available, or select Other to specify any other 
legal character.

Note: Some delimiters are: space, quotation marks, period, minus, plus, and 
underscore.

As you select options in the dialog box, the sample text changes.

4. Select a Text Qualifier from the drop-down menu. Choices for the Text Qualifier include: 
none, double quote, and single quote. 

5. Check the First line has field names check box and Centrus Desktop performs an 
additional error check. 

Note: Precisely recommends that you do not select Fixed Width as the file type with 
the First line has field names option. A list of field names which exceed the field 
width generally occurs.

As this process of validation occurs, Centrus Desktop compares each field name to the 
field width, then displays a list of field names which exceed the field width in an error 
dialog box and halts processing.
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Early Warning System data
The Early Warning System (EWS) provides up-to-date address information for new and 
recently changed addresses that have not yet been updated in the monthly USPS data 
updates. EWS prevents address records from miscoding due to a delay in postal data 
reaching the USPS address matching files.

The older the U.S. Postal Databases, the higher potential you have for miscoding 
addresses. When a valid address is miscoded because the address it matches to in the 
U.S. Postal Database is inexact, it will result in a broken address.

EWS data consists of records containing partial address information limited to the zip code, 
street name, predirectional, postdirectional, and a suffix. For an address record to be EWS-
eligible, it must be an address not present on the most recent monthly production U.S. 
Postal Database.

The USPS refreshes the EWS file on a weekly basis. You can download the EWS file from 
the USPS Web site at https://postalpro.usps.com/cass/EWS.

Note: In order to use the USPS-supplied EWS file, GeoStan requires that the EWS file be 
named ews.txt and be located in the GeoStan data search path. The date of the EWS 
file must be the same month or newer than your GeoStan data files.

https://postalpro.usps.com/cass/EWS
https://postalpro.usps.com/cass/EWS
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User Dictionary
This chapter includes information on creating User Dictionaries, source data requirements 
and required fields, and other information specific to working with User Dictionaries.

Note: User Dictionaries are not for use with CASS geocoding.

• Understanding capabilities and requirements
• Source data requirements
• Required input fields
• Optional (recommended) input fields
• User Dictionary file names and formats
• Additional User Dictionary considerations

– Data access license
– Use without GSD data files
– CASS standards
– Address range order
– Street intersections and User Dictionaries

• Using User Dictionaries with address point interpolation

Understanding capabilities and requirements
The capabilities of User Dictionaries and the basic requirements for creating them are as 
follows.

• All fields supported by normal street geocoding can be included in User Dictionaries.
• Landmarks and place names are supported in User Dictionaries. Postal or 

geographic centroid geocoding are not supported in User Dictionaries.
• User Dictionaries support address browsing using partial street names or landmarks 

and place names.
• GSDs are necessary to create the User Dictionary. This is because the GSDs have 

some internal structure that must be available when creating a User Dictionary.

The results from a User Dictionary are similar to that from the GSD. For address matches 
where the first letter of the match code would be 'S', a User Dictionary match has the letter 
'J'. For example: SE9 is a match code for a match that comes from a GSD, while JE9 is for 
a match that comes from a User Dictionary. See Status codes for a complete description of 
match codes.

Source data requirements
The source data for User Dictionaries includes street data but can also include place names 
and intersections.

To create a User Dictionary, your source data must conform to the following requirements:
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• Source records must include required fields, and these fields are mapped during the 
User Dictionary creation process. If a value of a required field is empty for a 
particular record, then that record will not be imported into the User Dictionary. 
Required fields may vary for different countries. The MapInfo® table must contain 
specific fields, which GeoStan™ then uses to convert the table into the dictionary 
format. These input fields are described in Required Input Fields on page.

• Source records must be in a MapInfo table (TAB file). The TAB file requirements 
vary for different countries.

• Segments must have two or more defined endpoints to be loaded into a User 
Dictionary. Segments without endpoints are ignored.

• Segments that make up intersections must have one or more end points in the 
intersection for GeoStan to recognize it as an intersection. Source records can be 
either point objects or segments.

• Each row in the table is equivalent to a street segment.

Required input fields
You must specify the field names in the MapInfo table (TAB file) in order for the table to be 
translated into a User Dictionary. Certain fields are required and must be present in the 
MapInfo table. Other fields are optional, but are strongly recommended because there may 
be negative consequences if they are omitted. This is described in Optional 
(Recommended) Input Fields on page Optional (recommended) input fields. If any of the 
required fields are missing, a missing field error code is returned.

The following table describes the required input fields.

Optional (recommended) input fields
The Left and Right Odd/Even Indicator fields are used to specify whether the sides of the 
street segment contain odd or even address ranges. Although these indicators are not 
required for creating a User Dictionary, it is important to use the Odd/Even Indicators when 
your data contains odd/even address numbers.

Required fields Description
Maximum field 
length

Left start address Start of address range on left side of street. 10

Right start address Start of address range on right side of street. 10

Left end address End of address range on left side of street. 10

Right end address End of address range on right side of street. 10

Street name Name of street. 30

State abbreviation Two-character state abbreviation. 2

Left ZIP Code ZIP Code for left side of street. 5

Right ZIP Code ZIP Code for the right side of the street. 5



 

Centrus Desktop User Guide for Windows 103

When the Odd/Even Indicator is specified, but is inconsistent with address numbers, the 
indicator is set to Both.

When the Odd/Even Indicator is not specified and both Start Address and End Address 
have values, the indicator is set to Both, unless the start and end address numbers are the 
same number. In that case, the indicator is set to Odd if the address numbers are odd, and 
set to Even if the address numbers are even.

When the Odd/Even Indicator is not specified and both Start Address and End Address 
have values, the indicator is set to Both (odd and even).

Note: If your table contains Odd/Even indicator information, we strongly recommend that 
you use the Odd/Even indicator fields. These fields ensure that your geocoded 
addresses are located on the correct side of the street. Omitting the fields when your 
data contains Odd/Even information may produce incorrect results.

The following table describes the optional input fields.

* These fields are highly recommended.

User Dictionary file names and formats
GeoStan has some requirements for User Dictionary files that you must be aware of before 
you create a User Dictionary:

• Each User Dictionary has a base name of eight characters or fewer.
• Each User Dictionary resides in its own directory.
• The maximum length of a path to a User Dictionary is 1024 characters.
• The ZIP Code range in the MapInfo table for a User Dictionary is unlimited.

Because each User Dictionary resides in its own directory, User Dictionaries may share the 
same name. However, it is generally good practice to use a unique name for each User 
Dictionary.

Optional fields Description
Maximum field 
length

Left Odd/Even indicator* Left side of the street contains only odd or even 
address ranges (O=odd, E=even, B=both)

1

Right Odd/Even indicator* Right side of the street contains only odd or even 
address ranges (O=odd, E=even, B=both)

1

City* City name 28

Left ZIP + 4 Code  4-digit ZIP + 4 add-on for left side of street. 4

Right ZIP + 4 Code  4-digit ZIP + 4 add-on for right side of street. 4

Left Census Block Census Block ID for left side of street 15

Right Census Block Census Block ID for right side of street 15

Place Name Place name 40



 

Centrus Desktop User Guide for Windows 104

Some of the output files are tied to the base name. The other output files have constant 
names. For example, the output files for a dictionary called ud1 are the following:

postinfo.jdr
postinfo.jdx
lastline.jdr
post2sac.mmj
geo2sac.mmj
sac2fn_ud.mmj
ud1.jdr
ud1.jdx
ud1.bdx

If your data includes place names, the dictionary contains the following files:

ud1.pdx
ud1.pbx

The dictionary also contains these log files:

ud1.log
ud1.err

Additional User Dictionary considerations
See the following topics for more information when working with User Dictionaries.

Data access license

You must still have a valid access license to the data contained in the GSD when you are 
geocoding against your User Dictionary. For example, if you create a dictionary of New York 
streets and addresses, you must purchase the New York or entire U.S. GSD.

Use without GSD data files

To utilize a User Dictionary without the use of GSDs, the files listed below are required:

• ctyst.dir - The USPS City State table.
• parse.dir - The GeoStan dictionary

To perform postal centroid geocoding, in addition to a GSD or a User Dictionary and the 
files listed above, the following files are necessary: 

• us.z9  - Postal centroid information.
• cbsac.dir - Required only if county names or CBSA/CSA data are needed.

CASS standards

You cannot geocode to CASS standards using a User Dictionary. This also means that the 
ParcelPrecision Dictionary cannot be used during CASS geocoding.

Address range order

GeoStan determines the order of the address range based on a comparison of the start and 
end addresses. The comparison produces the following results:
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• If the end is greater than the start, the range is ascending.
• If the start is greater than the end, the range is descending.
• If the start is equal to the end, the range is ascending.

Street intersections and User Dictionaries

When geocoding to street intersections with a User Dictionary, GeoStan cannot recognize 
the intersections if one or more of the segments that make up the intersection does not 
have an end point at the intersection. This can happen when you create the User Dictionary 
from a customized street table in which some segments that terminate at intersections do 
not have end points (Example 1).

Example 1: Intersection in User Dictionary does not have end points for all segments. 
GeoStan does not recognize this as an intersection.

Example 2: Intersection in TIGER-based GSD includes end points for all segments. 
GeoStan geocodes to this intersection.

Using User Dictionaries with address point interpolation
An important part of the process of creating a User Dictionary is to specify a mapping of 
fields from your source data. See the MapInfo User Dictionary Utility Product Guide, for a 
complete discussion. There are two main categories of data fields: required and optional.

Of the optional fields, there are two that have an impact on the address point interpolation 
feature. These are the "Left Odd/Even" and "Right Odd/Even" fields. If these are not 
populated, the results from address point interpolation is less accurate.

Please be aware that aforementioned fields are not populated by source data obtained via 
MapInfo StreetPro. You must modify the source TAB file by adding the "Left Odd/Even" and 
"Right Odd/Even" indicator fields, and create queries to populate them. Source data 
obtained from other products, or your own data, may have similar issues.
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To add the "Left Odd/Even" and "Right Odd/Even" indicator fields to a source TAB file, you 
must add them and then run a series of SQL update queries to populate them. The fields 
should be filled in with “O” (odd), “E” (even), or “B” (both). Below are the steps for adding 
these fields:

1. Add two 1-char columns to your TAB file.

Naming each column, for example, Ind_Right and Ind_Left.

2. Perform the following updates to populate these fields: 

• Update <tablename> 

Set Ind_Left="E", Ind_Right="O" 

Where From_Left mod 2=0 AND To_Left mod 2=0 

• Update <tablename> 

Set Ind_Left="O", Ind_Right="E" 

Where From_Left mod 2=1 AND To_Left mod 2=1 

• Update <tablename> 

Set Ind_Left="B", Ind_Right="B" 

Where From_Left="" AND To_Left="" 

Note: These example queries are simplified for illustrative purposes. Your actual queries 
may need to be more complex.
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Auxiliary files
This section contains information on using auxiliary files for matching address lists.

• Auxiliary file matching overview
– Creating auxiliary files
– Matching to auxiliary files

• Auxiliary file layout

Auxiliary file matching overview
Although Precisely provides robust data for you to match your input address lists against, in 
some cases you may want to match your address lists against special data. Centrus 
Desktop provides you with the ability to create auxiliary files to match against special data.

Creating auxiliary files
You can create customized auxiliary files that contain records that meet your particular 
needs to use in Centrus Desktop when matching address lists. This section contains 
information on creating auxiliary files, and contains the following topics:

• Auxiliary file requirements
• Record types
• Auxiliary file organization
• Default values

Auxiliary file requirements

Centrus Desktop requires that the auxiliary file comply with the following:

• File must be a fixed-width ASCII text file
• File must have a .gax extension
• File must have less than 500.000 records
• File must follow the column field order and lengths specified in “Auxiliary file layout” 

on page 111.

Record types

There are two types of auxiliary file records:

• Street Records – A street record contains a range of one or more addresses on a 
street. To be a valid street record the record must have the following fields:
– ZIP Code
– Street name
– Street type abbreviation, if part of the address
– Pre-directional abbreviation, if part of the address 
– Post-directional abbreviation, if part of the address
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– Low house number within the street segment
– High house number within the street segment
– Beginning longitude of the street segment
– Beginning latitude of the street segment

In addition, a street record may NOT have:

– Secondary address information, such as unit numbers
– Mailstops
– Private mail boxes (PMBs)

• Landmark Records – A landmark record represents a single site. To be a valid 
landmark record the record must have the following fields:
– ZIP Code
– Name of the landmark – placed in the street name field
– Beginning latitude of the landmark
– Beginning longitude of the landmark

In addition, a landmark record must NOT have the following fields:

– Street type abbreviation
– Pre-directional abbreviation
– Post-directional abbreviation
– Low house number
– High house number

Centrus Desktop ignores any record that does not comply with the preceding requirements.

Auxiliary file organization

You must comply with the following organizational rules when creating your auxiliary file.

• Use semicolons in the first column to indicate a row is a comment, not a data record; 
Centrus Desktop ignores rows that begin with a semicolon. 

• Order the records within the file by descending ZIP Code then descending street 
name for optimal performance.

• All records must represent only one side of a street. To represent both sides of a 
street, you must create a record for each side of the street.

• All records must represent segments that are straight lines. Records cannot 
represent a non-straight segment.

• If house numbers are present in the record, the house number range must be valid 
according to USPS rules documented in Publication 28, Appendix E.

• The numeric fields, such as ZIP Codes, must contain all numbers.
• Latitude and Longitude values must be in millionths of decimal degrees.
• Records cannot contain PO Box addresses.
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Default values

Centrus Desktop uses the following defaults if you do not include the values in the auxiliary 
file:

• House number parity = B (both odds and evens)
• Segment direction = A (ascending)
• Side of street = U (unknown)

Matching to auxiliary files
This section provides information on the matching performed by Centrus Desktop to 
auxiliary files, and contains the following topics:

• Matching overview
• Record type matching rules
• Unavailable Centrus Desktop features
• Auxiliary match output

Matching overview

Centrus Desktop performs the following steps when matching an input address to an 
auxiliary file:

1. Centrus Desktop determines if there is an auxiliary file present.

Centrus Desktop only accepts one auxiliary file. If more than one auxiliary files is 
present, Centrus Desktop attempts to match against the first file. Centrus Desktop 
ignores any additional auxiliary files for matching, regardless if Centrus Desktop found a 
match to the first auxiliary file. 

If a record within the auxiliary files is invalid, Centrus Desktop returns a message 
indicating the auxiliary file has an invalid record. Centrus Desktop continues to process 
input addresses against the auxiliary file, but will not match to the invalid auxiliary file 
record.

2. If an auxiliary file is present, Centrus Desktop first attempts to match to the auxiliary 
file.

Centrus Desktop assumes that the auxiliary file is the most accurate data set and first 
attempts to find a match to the input address in the auxiliary file. If Centrus Desktop 
cannot find a match in the auxiliary file, it continues to process as normal against the 
traditional Centrus Desktop datasets.

Note: Centrus Desktop only matches your input address lists to your auxiliary file if 
there is an exact match. Therefore, your input address list should be as clean as 
possible; free of misspellings and incomplete addresses. 
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3. If Centrus Desktop finds an exact record match to the auxiliary file, it standardizes the 
match to USPS regulations and returns the output of the auxiliary file match.

Note: You cannot update the auxiliary file while Centrus Desktop is running. If you want 
to update the auxiliary file, you need to terminate Centrus Desktop before 
attempting to replace or edit the file.

Record type matching rules

When attempting a match against an auxiliary file, Centrus Desktop abides by the rules 
outlined here.

Street record match:

• The input house number must fall within or be equal to the low an high house 
number values of the auxiliary record.

• The input house number must agree with the parity of the auxiliary record.
• The input ZIP Code must exactly match the ZIP Code of the auxiliary record.

Landmark record match:

• The input data must contain both a ZIP Code and address line, and they must 
exactly match the values on the auxiliary record.

• The input address cannot have any other data, such as a house number, unit 
number, or Private Mail Box (PMB).

Note: Centrus Desktop only matches the ZIP Code against the auxiliary file. Centrus 
Desktop does not verify that the ZIP Code of the input address record is correct for 
the city and state. You should validate this information in your input lists before 
processing against the auxiliary file.

Unavailable Centrus Desktop features

The following list outlines the features that do not apply when Centrus Desktop makes an 
auxiliary file match:

• Centrus Desktop does not match to
– two-line addresses
– multi-line addresses
– intersection addresses
– dual addresses

• You cannot use auxiliary file matching when processing in CASS mode.
• Centrus Desktop does not perform EWS, ZIPMove, LACS/Link, or DPV processing 

on auxiliary matches.
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Auxiliary match output

Several standard Centrus Desktop outputs do not apply to an auxiliary match since Centrus 
Desktop matches to an exact auxiliary match and does not perform any additional validation 
for the match. For example, Centrus Desktop does not return the block suffix, the check 
digit, or any DPV enum. 

Centrus Desktop provides special data type, match codes, and location code values for 
auxiliary matches. 

When Centrus Desktop finds a match to an auxiliary file, the default output is follows the 
following conventions: 

• Centrus Desktop formats the auxiliary file match as a street-style address for output. 
This excludes PO Boxes, Rural Routes, General Delivery, etc.

• Centrus Desktop follows the casing setting you indicate (by default, upper case) by 
the casing function. Centrus Desktop does not maintain the casing in the auxiliary 
file for mixed casing values. For example, Centrus Desktop returns O’Donnell as 
ODONNELL or Odonnell depending on the setting of the casing function.

Note: Centrus Desktop does not change the casing for the User Data field.

• Centrus Desktop removes spaces at the beginning and ending of fields in the 
auxiliary file.

Note: Centrus Desktop does not remove spaces for the User Data field.

Auxiliary file layout
For an example of an auxiliary file, see Program Files\Centrus\Geolib\Common.

Field Description Required

Required 
for Street 
Segment 
Match

Required 
for 
Landmark 
Match

Exact 
Match 
Required 
if Present Length Position

ZIP Code 5-digit ZIP Code. X X X X 5 1-5

Street name Name of the street or landmark. X X X X 30 6-35

Street type 
abbreviation

Street type. Also called street 
suffix.
See the USPS Publication 28, 
Appendix C for a complete list of 
supported street types.

X 4 36-39

Pre-directional USPS street name pre-
directional abbreviation. 
Supported values are N, E, S, W, 
NE, NW, SE, and SW.

X 2 40-41

Post-directional USPS street name post-
directional abbreviations. 
Supported values are N, E, S, W, 
NE, NW, SE, and SW.

X 2 42-43

RESERVED RESERVED 4 44-47

Low house number Low house number of the 
address range.

X X 11 48-58
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High house 
number

High house number of the 
address range.

X X 11 59-69

House number 
parity

Indicates the parity of the house 
number in the range.
• E – Even
• O – Odd
• B – Both

1 70

Segment direction Direction the house numbers 
progress along the segment:
• F – Forward (default)
• R – Reverse

1 71

RESERVED RESERVED 1 72

FIPS state US government FIPS state 
code.

2 73-74

FIPS county US government FIPS county 
code.

3 75-77

Census tract US Census tract number. 6 78-83

Census block 
group

US Census block group number. 1 84

Census block ID US Census block ID number. 3 85-87

RESERVED RESERVED 5 88-92

State abbreviation USPS state abbreviation. 2 93-94

County name Name of the county. 25 95-119

MCD code Minor Civil Division code. 5 120-124

MCD name Minor Civil Division name. 40 125-164

CBSA code Core Based Statistical Area 
code.

5 165-169

CBSA name Core Based Statistical Area 
name.

49 170-218

RESERVED RESERVED 5 219-223

City Name City name. Overrides the 
city/state preferred city name 
upon a return.

40 224-263

RESERVED RESERVED 237 264-500

User-defined data User-defined data. 300 501-800

Record ID Number User-defined unique record 
identifier.

10 801-810

Field Description Required

Required 
for Street 
Segment 
Match

Required 
for 
Landmark 
Match

Exact 
Match 
Required 
if Present Length Position
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Side of street Side of the street for the 
address:
• L – Left side 
• R – Right side
• B – Both sides
• U – Unknown side (default)
This is relative to the segment 
endpoints and the segment 
direction.

1 811

Beginning 
longitude

Beginning longitude of the street 
segment in millionths of 
degrees.

X X X 11 812-822

Beginning latitude Beginning latitude of the street 
segment in millionths of 
degrees.

X X X 10 823-832

Ending longitude Ending longitude of the street 
segment in millionths of 
degrees.

11 833-843

Ending latitude Ending latitude of the street 
segment in millionths of 
degrees.

10 844-853

Field Description Required

Required 
for Street 
Segment 
Match

Required 
for 
Landmark 
Match

Exact 
Match 
Required 
if Present Length Position
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Glossary

A

address elements
The components of a street address, including house 
number, prefix direction, street name, street type, and 
postfix direction. These elements are parsed by 
GeoStan and should not be entered separately.

address geocoding
See geocode, geocoding.

address standardization
Address standardization is the process of taking an 
address and verifying that each component meets 
U.S. Postal Service guidelines for addresses. For 
example, when properly abbreviated, “123 Main 
Avenue” appears as “123 Main Ave.” During 
standardization, minor misspellings, dropped address 
elements, and abbreviations are corrected and the 
correct city, state, and ZIP Code are provided.

alias
A recognized alternate for a street name maintained 
by association in the database.

alias information
Data returned with certain enums when it exists. Not 
returned by all enums even if specifically requested.

alternate record
Additional or differing information that may be 
available about a specific address but that differs from 
the base record. See the enums table for necessary 
flag settings.

B

base record
The principle, rather than an alternate, record within 
the database.

block assignments 
(or blockface)
For the assignment of ZIP + 4 codes, one side of a 
street, from one intersection to the next.

C

carrier route
The addresses to which a carrier delivers mail. In 
common usage, a carrier route includes city routes, 
rural routes, highway contract routes, post office box 
sections, and general delivery units.

CASS
Coding Accuracy Support System. A service offered to 
mailers, service bureaus, and software vendors that 
improves the accuracy of delivery point codes, ZIP + 4 
codes, 5-digit ZIP Codes, and carrier route information 
on mail. CASS provides a common platform to 
measure the quality of address matching software and 
useful diagnostics to correct software problems.

CBSA
A statistical geographic entity consisting of the county 
or counties associated with at least one core 
(urbanized area or urban cluster) of at least 10,000 
population, plus adjacent counties having a high 
degree of social and economic integration with the 
core as measured through commuting ties with the 
counties containing the core. Metropolitan and 
Micropolitan Statistical Areas are the two categories of 
Core Based Statistical Areas.

CBSA Division
A subdivision of CBSA.

Census block ID
The 15-digit identification number used to specify a 
particular aggregate or block of addresses associated 
through census processes.

Census FIPS Code/Census ID
See FIPS code.

centroid
The calculated center of an area. The coordinates that 
define a centroid are the average of the sets of 
coordinates that describe the area.

centroid match
An address that has, through geocoding, been found 
to match a defined geocentroid.

city state key
A six-character USPS key that uniquely identifies a 
city name in the city/state file. Each city has a unique 
city state key.

CMSA name, CMSA number
Consolidated Metropolitan Statistical Area. The name 
represents the largest city in a statistical area. The 
number represents a 4-digit FIPS code.

County
The primary legal division of every state except Alaska 
and Louisiana. A number of geographic entities are 
not legally designated as a county, but are recognized 
by the U.S. Census Bureau as equivalent to a county 
for data presentation purposes. These include the 
boroughs, city and boroughs, municipality, and census 
areas in Alaska; parishes in Louisiana; and cities that 
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are independent of any county in Maryland, Missouri, Nevada, and Virginia. They also include the municipios in Puerto 
Rico, districts and islands in American Samoa, municipalities in the Northern Mariana Islands, and islands in the Virgin 
Islands of the United States. Because they contain no primary legal divisions, the Census Bureau treats the District of 
Columbia and Guam each as equivalent to a county (as well as equivalent to a state) for data presentation purposes. 
In American Samoa, a county is a minor civil division.

coordinates
See latitude/longitude coordinates.

CPO
Community Post Office. A contract postal unit that provides service in small communities where independent post 
offices have been discontinued. A CPO bears its community’s name and ZIP Code as part of a recognized address.

CSA
A geographic entity consisting of two or more adjacent Core Based Statistical Areas (CBSAs) with employment 
interchange measures of at least 15. Pairs of CBSAs with employment interchange measures of at least 25 combine 
automatically. Pairs of CBSAs with employment interchange measures of at least 15, but less than 25, may combine if 
local opinion in both areas favors combination.

D

datum
A mathematical model of the Earth used to calculate the coordinates on any map, chart, or survey system. Surveyors 
take an ellipsoid model of the Earth and fix it to a base point. The North American Datum (NAD) is the official reference 
ellipsoid used for the primary geodetic network in North America.

directionals
A geographic address line component that precedes (predirectional) or follows (postdirectional) the street name.

DPBC
The Delivery Point Bar Code is a POSTNET barcode that consists of 62 bars with beginning and ending frame bars 
and 5 bars each for the 9 digits of the ZIP + 4 code, the last 2 digits of the primary street address number (or post office 
box, and so on), and a correction digit. The DPBC allows automated sorting of mail to the carrier level in walk 
sequence.

DPC certified
Delivery point code certified. A software or hardware device that meets U.S.P.S. standards for evaluating a properly 
standardized ZIP + 4 code address and determines the correct 2-digit DPC and checkdigit.

E

eLOT
The Enhanced Line of Travel (eLOT) Product was developed to provide mailers the ability to sort their mailings in 
approximate carrier-casing sequence. To aid in mail sorting, eLOT contains an eLOT sequence number field and an 
ascending/descending code. The eLOT sequence number indicates the first occurrence of delivery made to the add-
on range within the carrier route, and the ascending/descending code indicates the approximate delivery order within 
the sequence number. Mailers can use eLOT processing to qualify for enhanced carrier route presort discounts.

F

Finance Area
A Finance Area is an area defined by the U.S. Postal Service from which it collects cost and statistical data. A Finance 
Area is frequently used for area searches, since it covers some or all of the ZIP Code areas in a town or city.

finance number
An assigned six-digit number that identifies and installation for processing it’s financial data. The first two digits are the 
state code and the next four are uniquely assigned from 0001 through 9999 to each installation in alphabetical order.
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FIPS code
Federal Information Processing Standards code. A FIPS Code, also called a Census ID, uniquely identifies each piece 
of Census geography. The syntax of the FIPS code is as follows:

ssccctttt.ttgbbb where: 
ss = the two-digit State Census FIPS Code
ccc = the three-digit County Census FIPS Code
tttt.tt = the 6-digit Census Tract Census FIPS Code
g = the single-digit Block Group Census FIPS Code
bbb = the Block Census FIPS Code

G

GDT
Geographic Data Technology data. Produced by TomTom, a premium vendor of street segment files.

geocode, geocoding
A geocode is the geographic information associated with a unique address or centroid, such as longitude and latitude. 
Geocoding is the process of assigning data based upon location information. GeoStan uses an address or ZIP Code to 
assign latitude, longitude, and Census FIPS information.

GIS
Geographic Information System. A computer-based tool for enhancing geographic data by analyzing both the physical 
location in space and the set of characteristics associated with a location.

GSD files
GeoStan directory files.

GsEnums
Enumerated types in the GeoStan API. These enums are prefixed with “GS_” and are defined in the geostan.h file.

GSL file
USPS eLOT and Z4Change data. This files is used to assign line of travel (LOT) codes to addresses.

GSU files
GSU files contain information to match addresses based on unique ZIP Code and additional highrise unit information.

GSX files
Geographic spatial index. These files are used by spatial functions and reverse geocoding in GeoStan.

GSZ file
GeoStan ZIPMove file contains USPS ZIPMove data.

H

handle
A reference to an object that is required by the Library and is not to be manipulated directly by the developer. The 
handle is generated when the library is initialized and is required for many library functions.

HERE
A premium vendor of street segment and point-level data, formerly known as "NAVTEQ".
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I

intersection matches
Intersections matches are indicated by an x___ match code. For example, 28th Street and Valmont intersections may 
be standardized and geocoded and return demographic information. Intersections do not represent a valid address for 
mailings.

L

LACS
Locatable Address Conversion System. This system corrects addresses electronically for areas that have undergone 
permanent address conversions. The address conversion occurred as a result of the 911 system implementation and 
involves renumbering and renaming rural route and highway contract route information as city-style addresses with 
street number and name.

lat/lon; latitude/longitude coordinates
Longitude and latitude coordinates are always in degrees, and are always represented as 64-bit doubles. Positive 
numbers represent the Eastern and Northern hemispheres, respectively, and negative numbers represent the Western 
and Southern hemispheres. For example, the point 140W by 30N would be represented as –140.0,30.0. The library 
always assumes that the longitude coordinate is the horizontal direction and the latitude coordinate is the vertical 
direction. Support is not provided for user coordinates.

location code
Location codes indicate the accuracy of the assigned geocode.

M

mail stop designator
This designator indicates a routing code used by a company for internal mail delivery.

MASS
Multiline (OCR) Accuracy Support System. A tool similar to Coding Accuracy Support System (CASS) that accesses 
and checks the address matching software used by customers’ multiline optical character readers (OCRs).

match code
Indicates the portions of the address that matched or did not match with the address information in the GeoStan data 
files.

match mode
The algorithm used by GeoStan to match an input address to an address in the data files.

match rates
The number of input addresses that correspond (can be matched) to address information in data files.

MBR
Minimum bounding rectangle. A geographic region defined by and minimum and maximum latitude and longitude.

Metropolitan Statistical Area 
A Core Based Statistical Area associated with at least one urbanized area that has a population of at least 50,000. The 
Metropolitan Statistical Area comprises the central county or counties containing the core, plus adjacent outlying 
counties having a high degree of social and economic integration with the central county as measured through 
commuting.

Micropolitan Statistical Area 
A Core Based Statistical Area associated with at least one urban cluster that has a population of at least 10,000, but 
less than 50,000. The Micropolitan Statistical Area comprises the central county or counties containing the core, plus 
adjacent outlying counties having a high degree of social and economic integration with the central county as 
measured through commuting.
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MSA name/number
Metropolitan Statistical Area. The name represents the name of the largest central city and the number is the 4-digit 
FIPS code.

match candidate resolution
The process of resolving an address match when more than one street segment has been identified as corresponding 
to the input address.

N

NAD
The North American Datum (NAD) is the official reference ellipsoid used for the primary geodetic network in North 
America.

NAD27
NAD27 has its origin at Meades Ranch, Kansas. NAD27 does not include the Alaskan islands and Hawaii. Latitudes 
and longitudes that are surveyed in the NAD27 system are valid only in reference to NAD27 and do not tie to any maps 
outside the U.S.

NAD83
NAD83 is earth-centered and defined with satellite and terrestrial data. NAD83 is compatible with the World Geodetic 
System 1984 (WGS84), the terrestrial reference frame associated with the NAVSTAR Global Positioning System 
(GPS) now used extensively for navigation and surveying. Note that TomTom uses WGS84 instead of NAD83. These 
two coordinate systems are compatible.

NCSC 
National Customer Support Center. The U.S.P.S. CASS support center can be reached at www.usps.gov/ncsc.

O

object
A basic functional unit of a library. A library contains functions that allow the user to create, manipulate, and destroy 
objects. C programmers access objects through handles that are provided through object creation functions.

P

postdirectional (postdir)
See directionals.

predirectional (predir)
See directionals.

R

record matching algorithm
Programmed logic that allows evaluation of the results of all field matching algorithms to determine whether two 
records match (i.e., are duplicates).

road class code
A key in the street segment file that identifies a road as major or minor according to the Census Feature Classification 
Code.

RR
Rural Route. A delivery route served by a rural carrier.
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S

soundex algorithm
A type of field matching algorithm that compares two fields based on their pronunciation.

soundex key
Generated by the GsSoundex function. Used to search the database by employing a soundex algorithm.

spatial query functions
Used to extract data from the GSD files. These functions specify the area to be searched through a minimum bounding 
rectangle rather than through city/state/ZIP or finance area.

stage 1 file
A sample address file provided by the U.S.P.S to determine if software/hardware meets postal requirements for CASS.

stage 2 file
An address file provided by the U.S.P.S. that is used to grade software/hardware to determine if it meets postal 
requirements for CASS.

street network files
Files provided by vendors (other than U.S.P.S.) the contain address and geocode information.

T

TomTom
A premium data vendor of street segment files (previously known as TeleAtlas).

TIGER files
Topographically Integrated Geographic Encoding and Referencing. A digital database of geographic features created 
by the US Geological Survey (USGS), covering the entire United States.

TLID
TIGER/Line® Identification Number.
The TIGER/Line® files use a permanent 10-digit TLID to uniquely identify a complete chain for the Nation. The 10-digit 
TLID will not exceed the value 231-1 (2,147,483,647) and represents the same complete chain in all versions of this 
file, beginning with the TIGER/Line® Precensus Files, 1990. The minimum value is 100,001. Topological changes to 
the complete chain causes the TLIDs to change. For instance, when updates split an existing complete chain, each of 
the new parts receives a new TLID; the old TLID is not reused.

As distributed, TIGER/Line® files are grouped by county (or statistically equivalent entity). A complete chain 
representing a segment of the boundary between two neighboring counties may have the same TLID code in both 
counties or it may have different TLID codes even though the complete chain represents the exact same feature on the 
ground. 

U

unit designator
Indicates the type of unit (e.g., apartment, unit).

USPS data files
Files provided by the post office containing address and ZIP Code information.

Z

ZIP + 4 directory file
Address records that contain the ZIP + 4 codes for all delivery points, in an electronic form.
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ZIP + 4 centroid geocoding
See geocoding.

ZIP Code
Zone Improvement Plan Code. Established in 1963 the five-digit numeric code of which the first three digits identify the 
delivery area of a sectional center facility or a major-city post office serving the delivery address area. The next two 
(the fourth and fifth) digits identify the delivery area of an associate post office, post office branch, or post office station. 
All post offices are assigned at least one unique 5-digit code. ZIP Code is a USPS trademark. 

ZIP + 4 is an enhanced code consisting of the 5-digit ZIP Code and four additional digits that identify a specific range 
of delivery addresses. The nine-digit numeric code, established in 1981, composed of two parts: (a) The initial code: 
the first five digits that identify the sectional center facility and delivery area associated with the address, followed by a 
hyphen; and (b) the four-digit expanded code: the first two additional digits designate the sector and the last two digits 
designate the segment. ZIP + 4 is also a USPS trademark.
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Index

Numerics

5 Digit Only 39
9 Digit Best Location 39
9 Digit Good Location 39
9 or 7 Digit Location 39

A

Add GSB 46
Add Table 48
Add to PIP Layer 52
Address Coding 10

input fields 27
input formats 27
multiline input 28
output fields 29

standardization elements 29
Address Coding Module

address line two preferences 25
available elements 30
Canadian address processing 25
output fields 57

address elements 29, 49, 57
creating new fields 29, 49, 57
geocode elements 30

U.S. address processing 24
Z4 change processing 25

Address Elements 29
Address Line 29, 30

Short 36
Address Line 2 30
Address Line Two Preference 40
Address location codes 75
Address Matching 38

Matching Tolerance 38
CASS 38
Close 38
Extended 38
GeoStan™ Close Mode 38
Interactive 38
Tight 38

Address Point Interpolation 40
Address Type 30
Address Wizard 14
Allow 5-Digit ZIP Code Census Centroid ID 40
Allow Ranged Address Numbers 41
APN ID 30
Assign Outputs 28, 49
Auto Search 14
Aux User Data 30
Available Outputs 46, 49

B

Backset 40
Batch 27, 47

Batch Process Task 10, 27, 46
Best Centroid 39
Blank if Unmatched 29, 49
Block Group Accuracy 39

C

Cancel 15
Carrier Route 29, 30
Carrier Route Sortation 30
CASS 38
CBSA Division Name 30
CBSA Division Number 31
CBSA Name 31
CBSA Number 31
Census Block 31
Census Block Group 30, 31
Census Block Suffix 31
Census ID Format 39
Census Tract 31
Census Tract Accuracy 39
Center 19
Centrus Data Files

Early Warning System Data 99
input table 93
output table 93
preparing 97

input text file properties 97
output text file properties 98

report files 94
audit report 94
log report 95

Centrus Desktop Tools
Data Viewer 43
Map Viewer 17
Shape Layers 51

Centrus Utilities Manual 6
Check Digit 29, 31
Check for First Letter Missing/Wrong 41
City 15, 16
City Delivery 31
City Name 31
City State Record Name 31
Clear All Except 9
Clear All Outputs 9
Clear Current Outputs 9
Clear Outputs 9
Close 38
Closest Site 10

output fields 49
Closest Site tab

adding layers from database table 48
CMSA Name 31
CMSA Number 31
Codes

Address location 75
Street centroid location 79
ZIP+4 centroid location 80
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Configuration 9
Coordinates 40
Copy Mailing Address To Clipboard 14
Country 15, 31, 38
County FIPS Code 31
County Name 31
Create Spatial Attributes 47
CSA Name 31
CSA Number 31

D

Data expiration 91
Data Type 32
Data Viewer 9, 43

using 43
Database

EWS 99
Default Match 32
Define Input Fields 27, 48
Delivery Point Barcode 29, 32
Demographic Coding Module

using 56
Demographics 10
Direction 46
Distance 46
DPV 15

Data expiration 91
Overview 88

DPV CMRA Indicator 32
DPV Confirmation Indicator 32
DPV False Positive Indicator 32
DPV Footnote 1 32
DPV Footnote 2 32
DPV Footnote 3 33
DPV No Stat 33
DPV Vacant 33

E

Early Warning System Data 99
Enable Buffering 47
Enhanced Building Search 40
EWS

Description of 99
USPS Web site 99

EWS data 99
EWS download address

USPS Web site 99
EWS Match 33
Exit 9
Extended 38
Extended Match Code 67
Extra Line 1-6 33
Extra/Mail Stop 33

F

False-positive address
Creating report 90
Detail record 90

False-positives
Overview 89

Finance area 39
Finance Area Search 39
Find 14
Firm Name 14, 29, 33
Firm Name Lookup 40
First hex position 66
First Letter Missing/Wrong 41
Frequency 26

G

Generate PMA 52
Geocode Defaults 9, 30
Geographic Determination 11
Geographic Determination Module

about 59
available elements 60
using 59

Geographic Determination tab 61
adding a line file 62
adding a polygon file 62
adding point file 61
importing a Geographic Determination file 62
removing files 63

Geographic Information System (GIS) 51
GeoStan Close Mode 38
GeoStan™ Close Mode 38
GIS 51

H

Help 10, 15, 19
Help Topics 15
High Rise Default 33
House 16
House Range 16

I

Incorporated Place Indicator 33
Info 19
In-Place Update 26
Installation

licensing 11
Interactive 38
Intersection Flag 33
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L

LACS Status 33
LACSLink 15
LACSLink

Data expiration 91
Overview 89

LACSLink Indicator 33
LACSLink Return Code 33
Last Line 14, 29, 33
Latitude 30, 33, 45, 48
Layers 19
Locate 19
Location Code 30, 34
Location Codes 75

GeoStan Canada 83
ZIP+4 Centroid

matches 83
Location codes

Address 75
Street centroid 79
ZIP+4 centroid 80

Log Output 26
Longitude 30, 34, 45, 48
LOT (Line of Travel) Number 34
LOT Direction Flag 34
Lot Size of Parcel 34

M

Map 14
Map Viewer 9, 17

manual geocoding 22
Map 14
using 17

Match Code 30, 34
Match Codes 65

“Ennn” 70
1st-3rd hex digit values 66
Canada 73
Extended Match Code (3rd hex digit) values 67
United States 65

Max Distance (Miles) 49
MCD Name 34
MCD Number 34
MEC Latitude 34
MEC Longitude 34
MEC Radius 34
menu 8
Metro/Micropolitan Flag 34
Minimum Quality 39
Mixed Case Output Addresses 41
MSA Name 34
MSA Number 34
Multiline 14, 28

N

NAD 27 40
NAD 83 40
Negate Longitudes 40
New Task 8
Next Error 27, 47

O

Offset 40
Offset/Backset 40
Open Task 8
Optimization Sort 28
Options 10
Output Assignment 29, 49
Output Corrected Last Line 41

P

Parcel Centroid Elevation 34
pbKey 35
PMA 51, 52
Point ID 35
Point-in-Polygon 10

output fields 49
Point-in-Polygon Module

object files and layers 50
point-in-polygon analysis 50

Point-in-Polygon tab
importing layers 47
removing layers 48

Postal Code 35
Postal Reports 41

Canada Post SERP Report
description 42

USPS 3553 (CASS) Report
description 42

Prefer Input ZIP over Input city 41
Preferred City Name 35
Primary Market Area (PMA) 51
Primary Post-Directional 35
Primary Pre-Directional 35
Primary Short Post-Directional 35
Primary Short Pre-Directional 35
Primary Short Street Name 35
Primary Short Street Suffix 35
Primary Street Name 35
Primary Street Suffix 35
Print 14
Private Mail Box (PMB) Designator 35
Private Mail Box (PMB) Number 35
Private Mail Box Designator 14
Private Mail Box Number 14
Process 27, 46
Process if Field is Blank 49
Process if Unmatched or Field is Blank 28
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Process Task 10, 27, 46
Processing Parameters 28, 48

Q

Query 14
Quick Find 9, 13
QuickFind

query directory navigation 15
search filter 16

R

Range Record Type 35
Ranged Address 41
RDI Return Code 35
RDIRDI

Overview 91
Recent File 9
Records 16
Redraw 19
Reject Records That Are Not 26
Release Notes 6
Report Files 10, 26
Reset 14
Residential or Business Indicator 35
Resolve the Address 14
Return coordinates in... 40
Rural Route Default 36

S

Save Task 9, 27
Save Task As 9, 27
Save values as Centrus Desktop defaults 15
Search Filter 14, 16
Second hex position 66
Secondary Post-Directional 36
Secondary Pre-Directional 36
Secondary Short Post-Directional 36
Secondary Short Pre-Directional 36
Secondary Short Street Name 36
Secondary Short Street Suffix 36
Secondary Street Name 36
Secondary Street Suffix 36
Segment ID 36
Select 19
Select Output File 26
Shape Layers 10, 51, 52
Short Address Line 36
Short City Name 36
Short Last Line 36
shortcut 8
Show In Map 52
Specifying data files 85
Standard 14, 27
Standardization Defaults 9, 29

State 15
State Abbreviation 36
State FIPS Code 36
Status 46
Street 16
Street Block 16
Street centroid location codes 79
Street Centroid Matching 39
Street Name 16
SuiteLink 15
SuiteLink Return Code 36

T

tab 10
Tables 10, 26
Task

Batch Process Task 10, 27, 46
New 8
Open 8
Process Task 10, 27, 46
Save 9
Save Task 27
Save Task As 9, 27

task
running tasks from the command line 87

Technical Support 6
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TIGER Face ID 36
TIGER Place Code 36
TIGER Urban Area ID (UACE 36
Tight 38
toolbar 8
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Unit 16
Unit Designator 36
Unit Designator 2 36
Unit Number 37
Unit Number 2 37
Urban Area Population  37
Urbanicity Indicator 37
Urbanization 37
Urbanization (Puerto Rico) 30
US Address Coding Options 40
US Geocoding Options 38
Use Address Point Interpolation 40
User Dictionary

Understanding 87
USPS Web site

EWS download address 99

V

Verify All 10
Verify Current 10
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Verify Tables 10
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Z4 Change Processing 41
Z4ChangeResult 37
ZIP 17
ZIP Centroid Matching 39
ZIP Classification 37
ZIP Code 37
ZIP Facility 37
ZIP+4 Extension 37
ZIP10 37
ZIP9 37
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Zoom Extent 19
Zoom In 19
Zoom Out 19
Zoom Street 17
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